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ABSTRACTABSTRACTABSTRACTABSTRACT

The present Master's thesis seeks to develop a better understanding of how to

model a project within Revit Structure by applying structural engineering industry

experience.  The goal is to provide a guide to students for the process of producing a

structural model with the intent to form construction documents for a project.  An

assessment of the software's user interface, including a comparison to the current

industry and education standard software was performed.  A suggested procedure for

modeling a project was developed.  This procedure involves performing the required

modeling tasks in an order that allows the user to best understand the modeling process

of a project.  Suggestions were given for the procedural steps of producing a model

based on structural engineering industry experience with the intention to maximize the

efficiency and usefulness of the structural model in a project setting.  Comments

regarding the use of Revit Structure on real New York City construction projects were

collected from experienced structural engineers at an established structural engineering

firm.  Advantages and disadvantages were considered from the perspective of the

structural engineer, including the concerns and input of other clients and consultants

that the structural engineer works with throughout the development of a project.

Ultimately, conclusions were formed on the usefulness of the program and its place

within the industry.  
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1. INTRODUCTION

The engineering industry has evolved over the years in the way that it creates 

drawings for the purpose of constructing projects.  Before the dawn of the computer, 

drawings were drafted entirely by hand.  After computers started becoming a part of 

every industry, programs were developed to draft architectural and engineering 

drawings on the computer.  Computer programs such as AutoCAD by Autodesk are 

used to create and modify construction documents in electronic versions that can be 

plotted to produce physical hard copies.  AutoCAD now dominates the industry for this 

purpose, and is a staple in every office related to the design and production of 

construction projects.  Drafting programs, however, are limited in their ability to aid in 

the design and construction process.  

Building information modeling (BIM) is most commonly defined as a process for 

creating a digital representation of the physical and functional characteristics of a 

building.  It usually consists of a three-dimensional model that aids in the efficiency of 

the design and construction process.  BIM is intended to incorporate the information 

that is necessary to see a project through the different phases of it's anticipated life. 

Beginning with the development of the building project, BIM can assist designers in the 

process of creating the architectural, structural, and mechanical, electrical, and 

plumbing (MEP) components of the building.  These components involve a broad list of 

design consultants that will provide information to be incorporated into the building 

design.  BIM can also include abilities that assist in the construction of a project such as 
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material takeoffs and scheduling.  Additionally BIM can also integrate information for 

some of the building's systems' processes during maintenance and service.  The 

organization and compilation of all of this information into a single model can help 

streamline the process of handing over a project from the design phase to the 

construction phase and ultimately through the building maintenance and service phase. 

Aware of AutoCAD's limitations, Autodesk began making efforts to provide a 

product beyond drafting software that would aid in multiple facets of the industry.  In 

keeping with such efforts, it purchased software called Revit from the company Revit 

Technology Corporation.  Revit was designed for the purpose of architecture, and was 

developed by a team that consisted of members with a design and construction 

background.

Revit Structure is a BIM program from Autodesk that allows structural engineers 

to develop a single three-dimensional structural model to aid in the design of and 

produce the required documents for a building construction project.  The edition of the 

program used for the purposes of this thesis was Revit Structure 2010.

2



2. THE REVIT USER INTERFACE

The Revit Structure user interface is different from previous versions of 

AutoCAD.  There is a learning curve when trying to adjust from one's experience with 

AutoCAD to being able to use Revit productively.  This does not mean that Revit cannot 

be learned within a reasonable amount of time, it just merely suggests that one cannot 

expect to immediately jump into using Revit comfortably because it is an Autodesk 

product like AutoCAD.  

One major difference between the two products is that Revit is element based, 

whereas AutoCAD is geometry based.  The significance of this in Revit is that each 

element that is created is more than just a drawing or graphical representation of the 

structure.  These elements contain much sophisticated information regarding the 

parameters and uses of the different pieces of the structure.  Another significant 

difference between the two programs is that with Revit all of the information for a 

structure is meant to be contained within one three-dimensional model.  This is vastly 

different from AutoCAD, in which the industry standard is to have a different drawing 

file for each sheet of a drawing set.  Therefore each floor plan is located in a different 

drawing file from the others, providing no connectivity amongst them.  Creating a 

model has both distinct advantages and disadvantages that will be discussed.  Other 

differences between the programs are seen in the way users access the tools of the 

program to perform different functions.
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Figure 1: The Revit User Interface and Toolbars

Ribbon

Revit has moved away from the multiple toolbar appearance that was found in 

previous versions of AutoCAD to a more distinct and organized form of accessing the 

different tools, commands, and views.  One example of this is the Ribbon along the top 

of the screen that contains the available tools broken down into a button, panel, and tab 

system.  The tabs are general categories that the user will need to become familiar with 

in order to know where the different tools are located.  The tabs are grouped in such a 

way that most of the tools that will need to be used around the same time are in the 

same general vicinity.  The tabs are then further broken down into panels, which group 

individual buttons of a similar type together.  There are also action tabs, which only 
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appear when performing certain tasks.  For instance, when clicking on an element 

button to create a particular object such as a beam, a Place Beam tab will appear that 

contains all of the modeling tools that will need to be used to properly create a beam. 

Project Browser

A new feature altogether is the Project Browser window located on the left side of 

the screen.  This window contains all of the views with which the user can access the 

model.  This is where the user will switch between structural floor plans, building 

elevations, section cuts, framing elevations, and the 3D view, among others.  There is 

also a list of other items that can be viewed from the Project Browser, including 

schedules, sheets, and families.  

Schedules are a necessary part of practically all drawing sets, and contain specific 

detailed information on certain elements such columns, beams, footings, or pile caps, 

among others.  The information is tabulated in these schedules to provide easy access to 

this information in one place without the need to constantly flip back and forth between 

numerous drawings.  Sheets will become the finished product for each drawing, and will 

show the titleblock and other relevant project information regarding the drawing that is 

not displayed by the model.  Sheets will be created to display the different views of the 

project, on which the information needed to construct the project will be provided. 

There are also families on the Project Browser, where the different element types that 

are loaded for each category can be displayed, and double-clicked to edit their Type 
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Properties.  Not all of the available families are loaded at the start of a project because 

memory is consumed by loading families.  To help the program run efficiently, it is best 

to only load the families that are required.  The Project Browser is a very helpful feature 

to navigate the immense amount of views and information that will be contained within 

the single three-dimensional model.

Figure 2: The View Control Bar Buttons

View Control Bar

At the bottom of the viewing screen, there is a View Control Bar, which allows the 

user to adjust different options to optimize the current view.  The Scale is also shown 

and can be edited on this bar.  The Detail Level button gives the ability to adjust the 

amount of detail from the options of Coarse, Medium, or  Fine.  While in the 3D view, it 

is recommended to keep the Detail Level on Fine if the computing power is available to 

use the model and program efficiently.  Although it should not have a dramatic effect, if 

this greatly slows down the performance of the program, then putting the Detail Level 
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on Medium should suffice for most three-dimensional viewing needs.  Having the Detail 

Level on Coarse is not nearly helpful as the other levels because it removes a great 

amount of detail from the model.  On the Coarse setting, the user is no longer able to 

see structural elements such as beams, columns, or braces, as they are replaced by lines 

for graphical simplicity.  In the plan view, however, the Coarse setting is recommended 

in order to graphically show the elements as simple lines, as this is industry standard for 

framing plans.  The higher level detail settings in plan view can be used to display 

elements in different ways depending on the needed use at the time.  The Detail Level 

button on the View Control Bar allows access for switching between these settings, and 

with a very fast refresh time after switching, it makes trying the different levels of detail 

a quick and easy process.  

The Model Graphics Style button allows the user to change the appearance of the 

model graphics in the viewing screen.  The different graphic options include Wireframe, 

Hidden Line, Shading, and Shading with Edges.  The Wireframe setting shows the 

outlines of every element, and displays the remaining portion as transparent so that 

members behind other members are visible.  Wireframe is suggested for use in plans 

views, or any view where it is necessary to see a background drawing.  For instance, the 

Wireframe setting needs to be turned on when viewing a slab edge background drawing 

in order to facilitate tracing the slab edges for new floor elements or opening elements. 

It should be noted that when viewing a particular level plan view with Wireframe, the 

levels below will not be able to be seen, which offers clarity when working on a single 
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level.  The Wireframe setting may also prove to be useful at times in the 3D view when 

trying to see elements that are behind others, but generally it is more recommended to 

hide particular elements for this purpose.  The ability to hid elements is explained 

further below in the portion describing the Temporary Hide/Isolate button.  

The Hidden Line setting shows the same outline of elements as the Wireframe 

setting, but with Hidden Line the remaining portion is white as opposed to transparent. 

This is a useful setting when viewing an elevation or section view, since it shows only 

the foremost elements and not the ones behind.  The Shading setting shows different 

levels of shading on the elements depending on the angle with which they are being 

viewed.  No outlines are shown on the elements, making it more difficult to discern 

where one element ends and another begins.  While it gives the opportunity to produce 

some interesting views of the model, it is most likely  that the Shading setting will be 

the least used of all the model graphics styles available to the structural engineer.  

The last option on the Model Graphics Style button is the Shading with Lines 

setting.  Shading with Lines shows the the same shading effects as the Shading setting, 

except now with an outline given to all elements, similar to the Hidden Lines setting. 

This provides a very clear view of the structure, and is strongly recommended as the 

most useful setting for viewing the model in 3D.  It is also recommended as an 

additional option for elevation views, providing a similar view to the Hidden Line 

setting, with slightly more detail by shading members shown at different angles or of 

different materials.   
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The Shadows button allows the users to turn shadows on or off for the model, 

which display how elements would block light from getting to other parts of the 

structure.  This is not a particularly important tool for structural engineers, but it is 

available.  It is also possible to change the location of the light source.

The Show Rendering Dialog button opens the Rendering window, where the user 

can find the Render button and specify the settings for rendering the model.  Rendering 

the model will provide the model with a very realistic look for all of the different 

structural elements based on their materials.  This ability requires an immense amount 

of computing power, however, and should only be used at times when the user does not 

need to perform any other actions and can leave the computer processing for an 

extended period of time to produce the rendering.  

The Crop View and Crop Region buttons allow the user to manipulate a viewing 

area to display only elements that are within the viewing area boundaries.  This is 

similar to a viewport in AutoCAD.  By putting the Crop Region button to the Show Crop 

Region setting, the boundary of the viewing area will be displayed as an outline around 

all or a portion of the model.  The Show Crop Region setting is on when the light bulb 

adjacent to the crop symbol on the button icon is lit, and the setting is off if the light 

bulb is off.  Clicking the button once will switch between the on or off setting.  Note that 

it may be necessary to zoom out in order to see the crop region viewing area outline.  

Toggling the Crop View button on or off will remove the portion of the model 

outside of the crop region from the view.  When the Crop View is off, this is graphically 
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represented by a red X adjacent to the crop symbol on the Crop View button.  When on, 

the red X is removed, showing just the crop symbol.  Clicking the button once will 

toggle between having the setting on or off.  Turning the Crop View on effectively 

creates a condition similar to a viewport in AutoCAD, by only showing the model within 

the editable boundary.  This tool plays an important role when creating sheets that will 

require having different portions or views of the model on a single sheet, with each view 

bounded by a set amount of viewing space.

The Temporary Hide/Isolate button allow the user to hide or isolate a particular 

element or category.  This ability is useful when wishing to view only one or a few 

elements or category types at time.  For example, all of the grid lines can be viewed by 

themselves by clicking on one of them, and then selecting Isolate Category from the 

Temporary Hide/Isolate menu.  This will leave only the grid lines in view, hiding all of 

the other categories.  The same could be done for all of the columns or other structural 

elements.  A combination of multiple categories could also be isolated.  The user can 

also view a single element such as a grid line by itself, by selecting the Isolate Element 

option.  Multiple elements or categories can be selected at once, and choosing to isolate 

them will affect all of the elements or all of the categories selected.

Selecting Hide Category does the reverse of Isolate Category, by removing the 

selected element category from the view, and leaving everything else revealed.  In this 

same way, Hide Element removes a single or multiple selected elements from the view, 

leaving all other elements in that category, as well as all other categories.  Multiple 
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elements or categories can also be hidden at one time if they are all part of the same 

selection set.

Hiding an element or category is useful to view the framing plan below a floor 

when the slab is blocking the view.  For example, the floor element can be selected, and 

by choosing the Isolate Element option, that particular floor will be removed from the 

view.  The same could be done to view all of the framing for an entire structure, by 

choosing Isolate Category to remove all of the floors, as opposed to just the one 

particular floor selected.  The Temporary Hide/Isolate button allows much more 

specific control over what elements are viewed than the Wireframe setting of the Model 

Graphics Style button.  

The elements that are hidden after using the Temporary Hide/Isolate button can 

be returned to the view by selecting the Reset Temporary Hide/Isolate option from the 

Temporary Hide/Isolate button menu.  The settings can also be permanently applied to 

the view by selecting Apply Hide/Isolate to View.   To temporarily toggle the elements 

or categories back into the view, the user can use the Reveal Hidden Elements button. 

This displays a cyan colored outline of all of the elements that were previously hidden. 

The isolated element will remain in the same graphics style that it was in when it was 

isolated.  When the Reveal Hidden Elements button is on, it is represented by the light 

bulb in the button icon being lit, and when the button is off the light bulb is not lit.

Multiple buttons from the View Control Bar can be used in combination to 

provide different results and views.  For instance, the Detail Level and Model Graphics 
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Style buttons can change settings for elements that were isolated or hidden using the 

Temporary Hide/Isolate button.  The user should become familiar with the different 

viewing options to create ideal views for the different tasks that will need to be 

performed when creating and using a model.

Zooming and Orbiting

There are dedicated toolbars for zooming and viewing the model in different 

ways in both 2D and 3D views.  A Navigation Bar on the right side of the screen displays 

two major buttons.  While in a two-dimensional view, the top button opens the 2D Wheel 

and the bottom button is a customizable zooming button.  While in a three-dimensional 

view, the top button opens the Full Navigation Wheel and the bottom button remains 

the same customizable zooming button.  In addition to the Navigation Bar, there is also 

a ViewCube with which to manipulate the views of the three-dimensional model.  

 The 2D Wheel is available while in a plan, elevation, section or other two-

dimensional view of the drawing.  It contains the buttons Zoom, Rewind, Pan, and a 

drop-down menu.  Clicking and holding down the Zoom button allows the user to zoom 

in or out from the model by dragging the mouse arrow.  Dragging the arrow up or right 

will zoom in, while dragging it down or left will zoom out.  The Rewind button allows 

the user to go to previous views.  Clicking on the button once will return to the most 

recent view, while holding the button down allows the user to see multiple previous 

views that can be revisited by dragging the mouse arrow to the thumbnail pictures of 
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the views.  The Pan button allows the user to move around the view in the current zoom. 

This is done by clicking and holding the button down, and moving the mouse around as 

desired.  The drop-down menu on the 2D Wheel gives the user access to a few additional 

buttons, including a Fit To Window option, which zooms to the largest view that will fit 

the full model.  

The Full Navigation Wheel for use in the three-dimensional views offers the user 

different options for exploring the model.  It has Zoom, Pan, and Rewind buttons similar 

to the 2D Wheel.  In addition to these, however, there is also an Orbit button that allows 

the user to orbit the model around a particular pivot point.  The user can place the pivot 

point at a location within the model by clicking and dragging the Center button, which 

is in the middle portion of the wheel.   The Walk button allows the user to experience 

the model by moving along a path within it.  It is, however, a relatively complicated 

viewing tool that is not particularly useful for structural engineers.  The Look button 

allows the user to keep their current viewing location, while looking in different 

directions to see multiple angles of the model from the same perspective.  The Up/Down 

button performs a similar ability to panning, except it is restricted to moving only up or 

down along a straight line.  

The customizable zooming button on the bottom of the Navigation Bar can be 

changed by clicking on the drop-down menu below the button.  The list of available 

buttons is then displayed and includes Zoom In Region, Zoom Out (2x), Zoom To Fit, 

Zoom All to Fit, Zoom Sheet Size, and Previous Pan/Zoom.  The default is the Zoom In 
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Region button, which allows the user to create a zoom box around a particular area to 

achieve a close-up view of that area.  The Zoom Out (2x) button zooms out in large 

bursts.  The Zoom To Fit button zooms to fit all visible objects on the screen, and the 

Zoom All To Fit button zooms to fit all visible objects and visual aids on the screen.  The 

Zoom Sheet Size button zooms to display the model within the sheet size.  The Previous 

Pan/Zoom button returns to the last view that was edited by zooming or panning.

It is recommended to use the ViewCube for most of the three-dimensional 

viewing needs.  The user can simulate the views is would like to achieve on the model 

by performing them on the cube.  For instance.  It provides the user with ability to orbit 

the model by clicking and dragging to orbit the cube.  Particular points on the cube, 

such as one of the sides, edges, or corners can be clicked on to provide a full model view 

of that particular point.  The Home button near the upper left hand corner of the cube 

allows the user to return to a specific default viewing angle.  The user can specify this 

viewing angle by clicking on the arrow near the bottom right hand corner of the cube, 

and selecting Set Current View As Home.  Other viewing and direction settings are 

available through the same arrow.  The ViewCube provides the user with the ability to 

quickly and easily manipulate the views of the three-dimensional model.

Options Bar

The Options Bar is a toolbar that appears directly under the Ribbon after or 

during certain actions are performed in Revit.  Some of these actions include selecting 
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an element or creating a new element.  The Options Bar provides faster ways to enter 

information about how to model an element, and helps define the element without the 

immediate need to access the properties windows of the element.  This ability allows the 

user to create elements more quickly.  The Options Bar also helps draw or modify 

certain elements in ways that streamline the modeling process.  Examples of this 

include options such as rotating elements immediately upon placement, or defining 

vertical elements' level extents.  There are a great multitude of options on the Options 

Bar for the various functions that need to be performed throughout the modeling 

process.  Refer to the individual sections that follow for specific information regarding 

the Options Bar while performing particular modeling tasks.

Status Bar

A Status Bar that provides information to aid in the modeling process exists on 

the bottom of the screen.  While in the middle of performing a particular command, it 

could give an instruction in the bottom left hand corner on the next action that needs to 

take place.  For instance, after clicking on the Beam button on the Structure panel of the 

Home tab, the Status Bar suggests “click to enter beam start point”.  After this action has 

been completed, it will read “enter beam end point”.  Brief and direct instructions such 

as these are helpful to the user in understanding how certain actions are performed 

while modeling.  Note that the Status Bar will only make suggestions for the next step of 

the current command, disregarding the need for tweaking options and settings to 
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perform the command as desired.  It is only intended as a guide through the actions, 

and not a thorough explanation of every step required to accurately model an element.  

The Status Bar can also display information for a particular element by placing 

the mouse arrow over that element.  For instance, if the user places the mouse arrow 

over a column element, which then outlines that element in purple, the Status Bar will 

display the column's family and type.  For other elements it will display other 

information, such as the tag that was given to a grid line.  There is also a counter on the 

far right side of the Status Bar that shows the number of elements selected at one time. 

Clicking on this counter opens up the Filter window, allowing the user to remove some 

of these selected elements from the selection set by category.  See the portion regarding 

the Filter ability in the Selecting Elements subsection.  The Status Bar should be 

referenced often to verify that the correct element is going to be selected, how many 

elements are selected, or for hints regarding the next step to complete for a command.

Press and Drag Check Box

The Press and Drag check box in the bottom right hand corner determines 

whether or not items can be clicked on and dragged by holding down the mouse on the 

selection.  If the check box is off, then clicking and holding the mouse button on the 

item will only create a selection box from the point initially clicked.  See the subsection 

below on Selecting Elements for more information regarding selection boxes.  If the 

Press and Drag check box is on, then clicking and holding the mouse button on the item 
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will allow the user to drag the item to a new location that is determined by when the 

mouse button is released.

Selecting Elements

After elements are clicked on in Revit Structure, they are highlighted in blue, 

signifying that they have been selected.  Upon selecting an element, a modification 

action tab is initiated, allowing the user to modify the current selection by accessing the 

list of editing buttons on the ribbon.  

An ability that has remained the same as it was with AutoCAD is the use of 

selection boxes.  Selection boxes are made by clicking on a point in blank space and 

holding down the mouse button while moving across the screen.  Note that if the Press 

and Drag box is turned off, the user can click and hold down the mouse button on blank 

space or an element to begin a a selection box, as mentioned above.  Starting a selection 

box and moving to the left will select any element that is touched by the selection box. 

Starting a selection box and moving to the right will only select elements that are 

completely encompassed by the selection box.  These directions are true regardless of 

whether the selection box is made moving up or down.  Therefore, moving either to the 

right and up or to the right and down will perform the same function, just as moving 

either to the left and up or to the left and down will also perform the same function.

If the user has selected multiple items by using a selection box, there may be 

some elements within that selection set that the user does not want to be included.  One 
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way to remove elements from a selection set is to use the Filter ability.  After multiple 

items have been selected, the Multi-Select action tab automatically opens up, displaying 

the Filter button on the Filter panel.  Clicking on the Filter button opens up the Filter 

window.  It can also be accessed by clicking on the selection counter on the far right of 

the Status Bar, as mentioned in the Status Bar subsection.  The Filter window displays 

the different categories of items selected, with a check box adjacent to the name of each 

category.  A count is also displayed showing the quantity of items within each category 

that is currently selected.  The user can filter out any undesired categories by 

unchecking the boxes adjacent to those element categories, and only keeping the ones 

to remain selected.  Clicking OK will keep only the categories with the check box turned 

on selected, and will deselect any categories that had the check box turned off.

While the Filter button allows the user to remove categories of elements from the 

selection set, there is also a way to deselect individual elements from a selection set. 

This is an ability that has not changed from AutoCAD and involves either adding items 

to or removing items from a set of selected items.  The user can hold down the Ctrl key 

to click on different elements to add them to the current selection set.  While the Ctrl 

key is being held down, the mouse arrow will have a small plus sign next to it to indicate 

that elements will be added to the selection set.  To deselect elements from the current 

selection set, the user can hold down the Shift key while clicking on selected elements. 

While the Shift key is being held down, the mouse arrow will have a small minus sign 

next to it to indicate that elements will be removed from the current selection set.  
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A different option for selecting multiple elements at once is the Select All 

Instances ability.  This is available by right-clicking on a particular type of element, and 

then clicking on Select All Instances, which automatically selects all members that are 

the same Type as the element that was clicked on.  The element Type is one of an 

element's defining properties, such as a particular wide-flange beam shape or a 

particular concrete section.  The ability to Select All Instances is useful to determine the 

quantity of elements of a particular type in the current view.  It also allows the user to 

edit a parameter of the elements' properties all at once while the elements are selected.  

Since the model in Revit is three-dimensional, there are often times when it is 

difficult to select elements because multiple elements are overlapping each other.  It is 

possible, however, to rotate through alternates for overlapping elements until the 

desired element is displayed, and can then be clicked on to be selected.  It is generally 

recommended to place the mouse arrow over the outline of the desired element, as in 

many instances this is the only place an element can be clicked.  To rotate through 

alternate elements, press the Tab key when the mouse arrow is over the outline of the 

desired element.  This will switch the purple outline from one element to the next, and 

can be repeated until the desired element is outlined in purple, and can be clicked on to 

be selected.  

One way to verify that the correct element was selected is to view the model in 

3D by accessing the 3D views on the Project Browser.  By manipulating the view until 

the desired area is displayed, the user can be certain that the desired element was 
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selected.  This is generally a recommended habit to have after not only selecting 

elements, but also after modeling elements in a project.  After creating an element or 

group of elements, it is strongly suggested that these elements are examined in the 3D 

view to be sure that the structure was created as desired.  This same procedure should be 

followed when copying or moving elements, or just modifying elements in general. 

Note that datum elements such as levels and grid lines, however, are not viewable in 3D. 

The 3D view is an extremely useful tool to verify that a structural element snapped to 

the correct location and at the correct elevation.  

While it is often difficult to determine if an element was modeled properly in the 

two-dimensional views, there are a few ways to more clearly understand how the 

element was modeled from within these views.  One way to do this is by simply selecting 

the element, which displays some of the elements characteristics.  An example of this is 

when viewing framing elements in a structural floor plan.  Lines that do not extend to 

the full length of beams are used to represent the actual shapes for drawing clarity, 

making it difficult to determine if beams have snapped to the correct locations.  Aside 

from viewing the model in 3D to verify the placement of a beam, the user can click on 

the beam to select it for more information.  This will display two solid blue dots at either 

end of the beam, noting the actual location of the start and end point of the selected 

beam.  The same is true for columns, walls, braces and other elements, depending on 

the current view.  
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3. THE LIFE CYCLE AND DESIGN PROCESS OF A BUILDING

Before attempting the modeling procedure for a project, a user should 

understand a building's life cycle, and particularly the general design process.  The life 

cycle of a building is typically considered to include its design, construction, use, 

maintenance, and demolition.  While this thesis is geared towards the modeling of a 

project for the design and construction portions of the building life cycle, BIM programs 

can be useful throughout the entire building life cycle, as previously mentioned.  The 

structural design engineer is generally only involved in the design and construction of 

the project, and rarely has a role beyond these phases.  The use and maintenance 

portions of a building begin after it has been constructed, and is occupied for the 

purpose that it was designed.  Structural engineers may only play a role during these 

phases if additions to the structure or an evaluation of the structure is requested.  The 

demolition stage includes the decommissioning of a building that will no longer be 

used.  The building and its systems may be dismantled or destroyed as required.  A 

demolition specialized structural engineer may be involved in the ultimate demolition 

of a project at the end of its life, but it is unlikely that the design engineer will be a part 

of the building's demolition unless it is only a renovation and not truly a demolition.  

The design process includes the conception of the ideas that will shape the 

project through to the final construction documents that will be used to build the 

project.  The first stage of the design process is the Schematic Design phase, in which 

information about the project is discussed with the client and design team in order to 
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meet the client's desired result.  The structural engineer will begin to address the needs 

of the structure by providing multiple options for the building structural system.  This 

often includes considering the different material options available for a project, such as 

reinforced concrete or structural steel.  Different design concepts are explored in an 

attempt to find the best direction for the project.  The structural engineer may also try 

to identify the project's specific design challenges in this phase.  Raising the particular 

challenges of a project early in the design process will force the entire design team and 

client to acknowledge the existence of the challenges and the resulting effects on the 

complexity of the project.  Typically basic floor plans will be produced during this phase 

for initial pricing comparisons.  Ultimately the goal of the Schematic Design phase is to 

figure out the path that the design will take, and which of the studied schemes will be 

the direction to follow for the project.

The next stage of the design process is the Design Development phase.  During 

this phase, the structural engineer will begin to refine the design of the project more 

thoroughly as more information becomes known.  As the architectural and MEP design 

progresses, the structural engineer can begin to assess and accommodate the structural 

requirements of the project as well.  The structural engineer will devise a working 

system for the different aspects of the structure, including how the structure will resist 

the gravity and lateral loads it will experience to both its superstructure and foundation. 

It is suggested that as many design decisions as possible should be made during this 

phase in order to prepare for the next design phase to produce construction documents. 
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The final stage of the design process is the Construction Documents phase.  By 

the end of this phase, the completed design of the structure needs to be finalized and 

displayed on the documents that will be used to construct the structure.  By the end of 

this phase, all of the details of the project for every member need to be designed and 

identified.  It is common for these documents to be produced and issued in portions, 

such as fifty percent construction documents or one-hundred percent construction 

documents.  Releasing the documents in portions helps meet specific goals for the 

design team, and also allows accurate pricing of different components of the project. 

The construction documents will be used to acquire bids from contractors, and allows 

them to obtain cost estimates from the subcontractors that will provide the required 

trades necessary to construct the project.

After the design of project is completed, the structural engineer will usually take 

part in the construction administration portion of a project.  During this process, the 

structural engineer will review construction submittals and be available to answer any 

questions that are raised during the construction of the project.  The construction 

submittals include shop drawings that are produced to detail the exact types, quantities, 

and sizes of the structural material to be used during construction.  Questions that are 

raised by the construction managers will include requests for information (RFIs) and 

other formal methods by which clarification can be requested for the issues that arise 

during construction.  Field visits and inspections may also be included as part of the 

structural engineer's scope of services during the construction administration process. 
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The structural engineer's role in this phase is to oversee the implementation of their 

design by providing approvals and clarification for the structural aspects of a project 

during construction.  The structural engineer must be able to resolve any problems 

relating to the structure that develop while the project is being constructed.  A BIM 

program can assist in the design and construction administration process by providing a 

detailed model that will aid in understanding and resolving the intricacies of a project.

While the above summary is a vague generalization of the typical design and 

construction phases often encountered by a structural engineer on a project, most 

projects will present different challenges and situations that will inevitably affect this 

process.  Different schedule constraints or involved parties may have small or dramatic 

effects on how the project will progress and will ultimately be designed.
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4. THE RECOMMENDED MODELING PROCEDURE

The procedure for developing a model begins with suggestions for how to start 

the project within the program.  Linking background drawings or a reference model for 

use as a guide when modeling will allow the structural engineer to determine the 

geometry of the structure and the structural requirements of the project.  Levels form 

the vertical datum to which the structural elements will be referenced.  Grid lines will 

be referenced as the horizontal datum for the structural elements.  

With background drawings or a reference model, levels, and a grid system, the 

user can begin modeling the structural elements.  The vertical column and wall 

elements should be modeled first as these will support the remaining structure for the 

floors.  Next, the beams and braces should be modeled to provide support for the 

structural floor.  With the framing members in place, the structural floor can be 

modeled.  Openings in the structural floor, such as penetrations for architectural, 

mechanical, electrical, plumbing or logistical construction requirements can be 

modeled after the structural floor.  Finally, the foundation of the structure is modeled 

last.  The reason for modeling the foundation last is that the superstructure above it 

needs to have been designed to a working level in order to develop the necessary design 

requirements for the foundation.
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5. STARTING A NEW PROJECT

The first step of creating a model is starting a new project, and the user begins by 

clicking on the Application button, placing the mouse arrow over the expansion arrow 

adjacent to New, and selecting Project.  This opens up the New Project window, which 

allows the user to browse for the location of the default structural template file.  The 

default structural template file has the Project Browser already set up with 

recommended views such as Structural Plans, 3D Views, and Elevations.  It is also 

possible to start a blank project without the use of any template files by selecting None 

under the Template File section of the window.  It is recommended at first, however, to 

choose the default structural template file to begin a project.  The user can also 

customize and save a template file that contains the desired views and elements for use 

on future projects.

Figure 3: The New Project Window for Starting a New Project
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After making the desired Template File selection, the user can choose to create a 

new Project or Project Template, by clicking on the appropriate selection.  Selecting 

Project allows the user to create a new project file in which to begin a model.  Selecting 

Project Template instead gives only the ability to create a template file.  It is suggested 

to select Project as this gives the flexibility to save the file as either a project or as a 

template.  If Project Template is selected, the user will only be able to save the file as a 

template file, and not as a project file.  Therefore to begin, select new Project and then 

click OK.  
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6. LEVELS

Adding the required levels of structure to a model is an extremely important step 

in development, as these levels will be used and referenced in many ways during the 

modeling process.  The levels are reference planes to which the structure will be bound. 

Therefore, if floor to floor heights or floor elevations change, the structure will 

automatically accommodate these changes.  

Like many different aspects of a project, this is an area that may see changes 

throughout the life of a project.  An architect may go through multiple iterations of a 

building layout, at times requiring the addition or deletion of levels.  As the architect 

determines the different uses of the spaces, the sizes and layouts of the spaces, and how 

the different spaces will stack from floor to floor, the structural engineer must 

accommodate the design requirements.  

This may mean that some structure will be at an intermediate height between 

two main floor levels.  This is not uncommon if there is a mezzanine level, a loft level, 

or an area with a particularly large slab drop.  A new level in Revit can be created to aid 

in the modeling of this intermediate level.  The levels of a structure will often need to 

be modified in particular ways.  Examples of these modifications include the possibility 

that floors will be renamed and floor elevations will be changed.  Levels should be 

created or modified in the elevation view.  
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Adding A New Level

From the elevation view, the user can create a new level by clicking the Level 

button on the Datum panel of the Home tab.  The Element Types for a level provide a 

few different options for how the level lines will be displayed.  The 1/4” Head selection 

will have a grid line pattern of one-quarter inch scale with a level head at one end of the 

line.  The Story Level selection uses a solid line instead of a grid line pattern, with a 

level head at one end of the line.  The Story Level – no head selection uses a solid line 

without a level head at the end of the level line.  Drawing the new level can be done by 

using either the Line or Pick Lines tools on the Draw panel of the Place Level tab.  Using 

the Line tool, the user can draw a line to create the level.  This is done by clicking a start 

point and an end point to draw the line.

The Options Bar while creating a new level with the Line tool shows a few options 

including a Make Plan View check box, a Plan View Types button, and an Offset text 

box.  The Make Plan View check box determines whether or not a corresponding plan 

view will be created along with the new level created in elevation view.  It is strongly 

recommended to create the plan view that corresponds with the new level in the 

elevation view.  This plan view is necessary to model structure and view the new level in 

plan.  The Plan View Types button should not need much use with Revit Structure, as 

the default and only option is for the Structural Plan view.  This plan view type is the 

only type that a structural engineer would be concerned with creating in their model. 

The Offset text box allows the user to specify a dimension that the new level will be 
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offset from the line that the user draws.  The level will be created either above or below 

the drawn line by entering the dimension as a positive or negative value.

To create a new level using the Pick Lines tool, the user can take an existing level 

line and draw a new parallel line with a specified offset to the selected existing level. 

After clicking on the Pick Lines tool on the Draw panel of the Place Level tab, the user 

needs to enter an offset dimension with which to create the new level.  Note that while 

using the Pick Lines tool, the user will not be able to select a line until a non-zero 

dimension is specified.  The Options Bar contains the same choices as when creating a 

new level using the Line tool, and the Offset text box works in the same way.  Once the 

offset is entered, the user can click on the existing level with which to use to create a 

new level.  When this has been done, a new level will be created with an elevation 

difference from the existing level elevation that matches the offset dimension that was 

entered.  Using the Pick Lines tool is the recommended procedure to create new levels 

for a structure.

After the level lines have been created, the user has the ability to change the 

length of the level lines by clicking on the start point or end point of the new level, and 

dragging that point to the desired new length.  Note that the default setting is that 

doing so will also perform the same operation to the other level lines that line up with 

this level line.  This is due to a locking ability that allows the user to keep the ends of the 

locked levels in line with each other.  When a level line is selected,  a lock symbol will be 

shown at each end of the line.  When the symbol is in the locked position, the locking 
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ability is enabled, and when the symbol is in the unlocked position, the locking ability is 

disabled for that particular level line.  The length of the individual level lines can also 

be modified later as required, by selecting the level line and then clicking and dragging 

the blue circle at the start or end point of the line.  Press the Esc key to complete the 

task and view the new level.  Once the level is created, it is automatically given a name 

tag and an elevation tag.  The name tag depends on the order in which the level line was 

drawn.  The elevation tag will show the level elevation value, based on the height at 

which the line was drawn.

The level name and elevation tags can be hidden by clicking on the check box 

that appears next to the start or end of the level line.  When the check box is filled, then 

the tag will appear.  The check boxes on both sides of the level line can be filled to 

reveal the level tag on both sides.  When there is no level tag being shown, the check 

box will just be an empty square. 

The user can also create an elbow in the level line if there are two level lines in 

close proximity of each other.  This helps avoid the level tags from overlapping and 

being unclear.  Click on the diagonal “z” or zigzag line near the end of the level line to 

create the elbow and kink the level line tag away from the other level line.  Solid blue 

dots will appear at the points of the elbow when the level line is selected, and the lines of 

the elbow can be modified as desired by dragging these dots.  

Modifications made to level lines in one elevation view can be applied to other 

similar elevation views.  For instance, if changes are made to the level lines of the North 
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elevation view, these same changes can be made to the South elevation view without the 

need to perform the same editing actions.  After selecting the modified level lines, the 

user can click on the Propagate Extents button on the Datum panel of the Modify Levels 

tab.  When the Propagate Datum Extents window opens, the user can add check marks 

to the other views to include the modifications.  When the user clicks OK, the 

modifications made to the selected level lines will be applied to the marked views of the 

Propagate Datum Extents window.

Figure 4: Level Line Tags with Name and Elevation, Level 4 Shown with an Elbow

Modifying A Level Name

When modifying a level name, the user should zoom in on the level tag to be 

modified while in the elevation view.  Double-clicking on the name of the level will 
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allow the user to modify it in a text box that appears.  After entering the new name, 

Revit will ask to rename the corresponding views.  It is strongly recommended to 

answer Yes, as this will rename the structural plan view that corresponds to that level, 

matching it with the new name given in the elevation view.  

It is always recommended to use the same naming convention when referring to 

the same area or level of a structure.  This goes not only for the structural engineer's 

own drawings between plans, elevations, sections and details, but also between the 

structural engineer's drawings and the other design consultants' drawings on a project. 

While different names for the same area may be understood between the design 

consultants, it must be kept in mind that others who are initially unfamiliar with the 

project will also need to review and understand the drawings.  For instance the 

contractor, subcontractors, and many others involved in the construction of the 

structure will need to be able to move from one design consultant's drawing to the next 

for the same area or level.  If the same level is named differently from the architect's 

drawing to the structural engineer's drawing, then this can create confusion and waste 

time.  Ideally the same standard should be applied for when subcontractors produce 

shop drawings that need to be reviewed by the design consultants.  From the perspective 

of a design consultant, however, one can only have control over their own drawings, and 

can only make suggestions or requests regarding the procedure for others.
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Modifying A Level Elevation

When modifying a level's elevation, the user should zoom in on the existing level 

elevation to be modified while in the elevation view.  The elevation of a level can be 

modified in the same way as its name.  Double-clicking on the elevation of a floor level 

will make a text box appear, in which the user can enter the floor elevation.  This is one 

example where having a single model is a true advantage.  Since Revit has the ability to 

communicate information between all of the different drawings of one model, when a 

level's elevation is changed in elevation view, this change is reflected in all other aspects 

of the model.  Specifically, all elements that are tied to that level, such as slabs, beams, 

columns and any other structural items that use the level as a reference, will be adjusted 

accordingly.  This saves a significant amount of drafting time, and also helps safeguard 

the user from forgetting to make a corresponding change.  Without this ability within 

Revit, the user could easily forget to make one of the many required modifications that 

follow when changing a significant design parameter such as a level elevation.

Figure 5: Created Levels For a Structure
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7. LINKING OR IMPORTING A DRAWING FILE AND/OR REFERENCE MODEL

Industry experience has shown that the overwhelming majority of a project's 

electronic drawings are started by the architect, and then are distributed to the other 

design consultants to apply their portion of the design.  In the case of structural 

engineers, this typically means receiving basic architectural floor plans early on during 

the schematic phase of a project, and then using these floor plans as a background to 

overlay the locations of the structural components of the project.  As more architectural 

drawings are created where structure needs to be included, the structural engineer will 

likely use these drawings as backgrounds, creating their own drawings by referencing 

these backgrounds.  It is important to note the terminology used in Revit for placing 

drawings into a model.  

Revit uses the term Link to refer to the process of taking a background drawing 

or another model and placing it into the current model for reference.  For background 

drawings, this is a similar ability to the external referencing process in AutoCAD.  One 

drawing file, such as an architectural background, can be placed into another drawing 

within AutoCAD for reference or tracing.  In a similar way, that same drawing can be 

placed into a view within Revit to serve the same purpose.  If the drawing is updated in 

AutoCAD, the most current version will be seen in Revit every time it is refreshed by 

opening the project or reloading the link.  This gives the user the ability to still draft 

certain parts of a project in AutoCAD, such as details, and then link them to Revit so 

that the details can be updated in Revit even if the changes are occurring in AutoCAD. 
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It is important to note that just like external references in AutoCAD, the drawings that 

are linked cannot be edited from within Revit.  To place a drawing into Revit that can be 

edited, one needs to import that drawing.

The term Import in Revit means that the file will be embedded into the model. 

This is similar to copying a drawing from one file and pasting it into another drawing 

file in AutoCAD.  There will be no connection between the imported drawing and the 

original drawing after it is imported.  If all drafting is planned to be done in Revit, then 

files can be imported from AutoCAD, and edited within Revit, no longer having a 

connection to the original AutoCAD drawing.  While linking a drawing gives more 

flexibility to the user in the ability to proceed to draft in either Revit or AutoCAD, this is 

not without consequence.  If a drawing is linked to Revit, it can only be edited in Revit if 

it is redrawn from within Revit by tracing the linked reference drawing.  Otherwise, the 

detail will need to be updated in AutoCAD as mentioned above.  Importing a drawing 

into Revit, however, allows the user to edit and manipulate the actual imported drawing 

after exploding it.

It is recommended to link drawings that are going to be used as backgrounds, 

just as background drawings would be externally referenced into a different AutoCAD 

drawing.  Importing drawings can be useful if taking existing details from AutoCAD to 

permanently place within Revit, where they can be edited and manipulated.  The 

determination needs to be made whether details will be edited from within Revit or 

AutoCAD.  If it is from within Revit, then any existing details can be imported from 
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AutoCAD.  If it is from within AutoCAD, then the details only need to be linked to the 

Revit model.

Linking a Revit model, such as an architectural model, can be done for the same 

purposes as linking an architectural drawing.  The architectural model will be displayed 

for reference, and the user can create structural elements to meet the architectural 

design.  For instance, datum elements such as levels and grid lines from the 

architectural model will be displayed and can be used to produce the datum elements 

for the structural model.  Similarly, the user can access other information such as slab 

edges that are shown within the architectural model to create the corresponding 

structural elements.  Like the external reference for a drawing file in AutoCAD, the 

linked model will be automatically updated to match changes made to the original 

model file whenever the user reloads the model.   

Linking or Importing a CAD Drawing

  When linking or importing a drawing, the user should first go to the appropriate 

view in which the drawing will be linked or imported.  If the drawing to be placed in 

Revit is a floor plan background, then the corresponding structural floor plan should be 

viewed.  To link the drawing file, click on the Insert tab of the ribbon, followed by the 

Link CAD button on the Link panel.  This opens the Link CAD Formats window, where 

the user can select the desired drawing file to link, and can enter the information for 

how this drawing will be linked.  Similarly, when importing a drawing into Revit, the 
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user can click on the Import CAD button on the Import panel of the Insert tab.  Now the 

desired file to import can be selected from the Import CAD Formats window, and the 

user can enter the information for how this drawing will be imported.  The parameters 

for how the drawing will be linked or imported include Colors, Layers, Import Units, 

and Positioning.  

Figure 6  :   The Link and Import CAD Window Options

The options for the drawing Colors include Invert, Preserve, and Black and White. 

From personal experience using architectural backgrounds with both Revit and 

AutoCAD, it is ideal for the background drawing to be monotone, so selecting Black and 

White is recommended as the best option.  Invert can be used if it is desired to have the 

drawing linked or imported in color.  This inverts the original colors so that they can be 
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seen more easily in Revit.  The contrasting white background in Revit does not provide 

the same viewing surface as the black background in AutoCAD, and therefore it is not 

recommended to use the same colors in the drawing.  Selecting Preserve will keep the 

original colors from the linked or imported file. 

Below Colors, there is the Layers option, which allows the user to choose whether 

the linked or imported drawing will include all of the layers that are in the drawing file, 

only the visible layers, or only specifically chosen layers.  This is done by selecting the 

appropriate choice of All, Visible, or Specify, respectively.  Linking or importing all of 

the layers gives the user the ability to turn specific layers on and off as desired, and is 

therefore the safest selection.  The layers can be manipulated by going to the View tab, 

and clicking on the Visibility/Graphics button of the Graphics panel.  Once the 

Visibility/Graphics Overrides window opens for the current floor, the user can click on 

the Imported Categories tab.  The linked or imported drawing file is shown here, and 

can be expanded to display all of the file's layers.  These layers can be turned on or off 

by checking or unchecking the box adjacent to the layer name.  The linked drawing can 

also be set to appear lighter in color by enabling the Halftone check box at the end of 

the row for the drawing file.

The manipulation of layers is a very useful tool if the architectural drawing is 

cluttered with multiple layers that do not need to be viewed all at once.  When an 

architectural drawing is unclear, the user should try to determine which layers are 

particularly important for structural reference and which may not be necessary. 
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Architectural layers that usually prove to be important are ones that include the grid 

lines, slab edges, slab openings, column/wall layouts, and stair/elevator locations.  While 

these are a few examples of  items to typically look for, there are likely others that will 

also provide useful information.  

Linking or importing with the Visible setting will exclude any of the layers that 

are turned off or not visible in the original drawing file the last time it was saved.  Note 

that if there are layers that need to be linked or imported with the drawing, these layers 

must be turned on and the drawing saved in AutoCAD in order to have access to them 

using the Visible setting.  Using the Specify setting, the ability to select which layers to 

include is not available until after the file is selected from the Link CAD Formats 

window or the Import CAD Formats window.  Therefore, all other linking or importing 

parameters need to be completed before choosing Layers.  After finishing the 

parameters, clicking OK to choose the selected file, will automatically open up a Select 

Layers/Levels to Import/Link window, where there are check boxes next to the list of 

available layers from the selected drawing file.  The desired layer selections can be 

specified by placing check marks next to the layers to be included and removing check 

marks from the layers to not be included.  With the layer choices made, the user can 

click OK to link or import the drawing with only those specified layers.  Once the 

drawing has been linked or imported, the layers that were not chosen to be included 

cannot be turned on later.  

The Import Units parameter is under the Layers option.  It is recommended to 
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just keep the Auto-Detect default selection, as this will detect the drawing file's units.  If 

the units that the user needs to work in are different from the units of the drawing file, 

there are also other units provided on the drop-down menu below Auto-Detect.  

Another drawing parameter is Positioning, which determines where the drawing 

will be placed within the coordinate system of Revit.  In general, the same coordinate 

location should be used as the drawing file, unless the original location was incorrect or 

is unwanted for a particular reason.  Noting from experience, it is ideal to have the same 

coordinates as the architect and other design consultants, as this will most likely not be 

the last time drawings are linked to the model.  

It is suggested to use the Auto – Center to Center option, which places the center 

of the drawing file in the center of the Revit view.  The Auto – Origin to Origin option 

can also be used to place the drawing file into Revit by its origin.  This is useful for cases 

where the drawing file that is being link or imported was originally created in Revit, and 

therefore has the same origin location.  The Auto – By Shared Coordinates option is 

useful if the Revit project and the linked or imported drawing file share the same 

coordinate system.  If not, Revit will align the drawing file's world coordinates with 

Revit's shared coordinates.  This can be used when linking or importing multiple 

drawing files that need to keep a set relationship to each other.  

The remaining selections are manually completed, and the user can place the 

background drawing using its origin, base point, or center by selecting Manual – Origin, 

Manual – Base Point, or Manual – Center, respectively.  The background drawing will 
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appear after clicking Open, and moves along with the mouse arrow until the desired 

location is clicked.  For Manual – Origin, the drawing will be moved with the mouse 

arrow fixed at the drawing file's origin.  Manual – Base Point will have the drawing fixed 

to the mouse arrow at the drawing file's base point.  Manual – Center will have the 

drawing fixed to the mouse arrow at the center point of the drawing file.

Figure 7: A Linked Drawing from AutoCAD

Linking a Revit Model

The user can begin linking a Revit model for reference by clicking the Link Revit 

button on the Link panel of the Insert tab.  This will open the Import/Link RVT window, 

where the user can search for the model to be linked.  Regarding the location where the 

linked model will be placed within the current model, the user will have the same 

options as there are when linking a drawing file.  See the above explanation of the 
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Positioning options in the Linking or Importing a CAD Drawing subsection for more 

information regarding the different options for Positioning.  It is recommended to use 

the Auto – Origin to Origin option for Positioning, as this should place the reference 

model's origin location of the current model.  Once the desired location is chosen and 

the Revit model file to be linked is selected, the user can click the Open button to load 

the reference model.  

Once the reference model is linked, the user can adjust visual parameters of the 

linked model using the option on the View Control Bar.  Refer to the View Control Bar 

subsection of THE REVIT USER INTERFACE section for more information on the 

buttons of the View Control Bar.  

Figure 8: A Linked Architectural Revit Model
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Reloading a Linked Drawing File or Model File

The user can reload linked drawing files or models by clicking the Manage Links 

button on the Link panel of the Insert tab.  This opens the Manage Links window, where 

the user can click on a file name under the Linked File column to highlight a specific 

file.  With the file highlighted, the user can Reload, Unload, or Remove the link.  By 

clicking on Reload, the user will refresh the connection to the linked original file, which 

updates any changes that were made and saved to the original file to view these changes 

in the current model.  The Unload button allows the user to temporarily disable the link 

between the file and the current model, so that it is not being displayed.  The file can be 

reloaded to reestablish that link.  Clicking on the Remove button will allow the user to 

delete the linked file from the current model.  To reestablish a link to the removed file, 

the user would need to link the file again in the same way it was linked originally.  

Figure 9: The Manage Links Window
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8. GRID SYSTEMS

Depending on the project, grid lines can prove to be the most important 

reference for locating anything anywhere on a given level of project.  If grid lines are 

not being used, the other commonly used reference system for buildings is coordinate 

based.  Industry experience has shown that most steel structures have been grid based. 

The majority of concrete structures have been coordinate based, with a few exceptions 

that were grid based.  

The reason for using the different systems with different materials lies in the way 

that the structures are constructed with those materials and their relative shapes.  For 

instance, the different elements of a steel structure are already fabricated when brought 

to a job site and have irregular shapes like wide-flange beams, whereas concrete 

elements need to be formed in place and are typically of simpler geometry.  While 

practically any shape can be made using concrete, in most cases the geometry is 

straightforward for simplicity and ease of construction.  Therefore with concrete 

structures, edges or corners of an element are located by a single coordinate point, and 

the size of the element is formed from this point.  For steel structures, elements are 

usually placed along or parallel to reference lines, or at intersections of reference lines. 

Any elements that do not meet this criteria are typically placed by dimensioning the two 

ends of the element off of grid lines.  

All structural elements are located in this way, as are architectural items and 

MEP items.  The grid or coordinate system is the main way of mapping out a project site 
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so that the design team can communicate real world locations to the construction team. 

Therefore, a well defined grid system must be developed to call out the locations of the 

significant elements of a project.  Typically every column that falls in some type of 

pattern capable of being gridded, will form a grid intersection.  It is usually a joint effort 

between the architect and structural engineer to come up with an agreeable grid system 

that will satisfy both of their locating needs.  It is of the utmost importance that the grid 

lines between design consultants are identical, as any differences will result in field 

issues and potential conflicts, and possibly even design problems before the conflict 

reaches the construction phase.  One good strategy in drawing grid lines is to trace an 

architectural background to ensure that the resulting structural grid lines will be the 

same.  In the beginning phase of a project this is typically first done to locate and 

determine column locations.

The column grid layout determines where the majority of the building's vertical 

support elements will rest.  The architect may attempt a first pass at this layout based 

upon the design of the spaces within the building.  Ultimately the structural engineer, 

however, will review this layout and will need to design the floor system and columns to 

determine if the chosen layout is efficient and practical, or at least meets the intent of 

the project.  The engineer will then recommend any necessary changes to improve upon 

the given layout.  While the general layout may be determined early on in a project, grid 

lines continue to be in flux well throughout the design phase.  As more information is 

known and more decisions are made regarding the architecture of the project, the 
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support elements will need to be adjusted to accommodate this new information.

Adding Grid Lines

In order to guarantee a grid that matches the architect's grid, the most recent 

architectural background should be linked to the appropriate plan view.  See the section 

on LINKING OR IMPORTING A DRAWING FILE for information on how to link a 

drawing.  To create a grid lines, the user can begin by clicking the Grid button on the 

Datum panel of the Home tab.  The element types for grid lines include the 1/4” Bubble, 

1/4” Bubble Custom Gap, and 1/4” Bubble Gap.  These can be selected from the Change 

Element Type drop-down menu on the Element panel of the Place Grid tab.

The 1/4” Bubble is a continuous dashed grid line of one-quarter inch scale with a 

bubble at the end of the line.  The 1/4” Bubble Custom Gap is a grid line that has a 

center segment that is a light-colored grid line of one-quarter inch scale, with solid line 

end segments, and a bubble at the end of the line.  The 1/4” Bubble Gap is a grid line 

that has only solid line end segments and blank space in place of a center segment, with 

a bubble at the end of the line.

Other types can be created by accessing the Type Properties window for grid 

lines.  This window is found is by clicking on the bottom drop-down portion of the 

Element Properties button, and then selecting Type Properties.   It can also be reached 

from the Instance Properties window, by clicking on the Edit Type button.  Once at the 

Type Properties window, the user should select the style of grid line that most closely 
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resembles the desired new grid line.  The style is in reference to the line being 

continuous, having a light-colored line between the ends, or blank space between the 

ends.  The user can click the Duplicate button to make a copy of that grid line type for 

editing.  This immediately brings up a Name window, in which the new grid line type 

should be given a name.  The new name will now be shown on the Type drop-down 

menu of the Type Properties window, and the parameters can be changed to the desired 

line.  Different line weights, colors, and patterns can be chosen for the line segments, as 

well as specifying the length of the end segment, among a few other options.  

The tools available to create grid lines are the Line and Pick Lines buttons on the 

Draw panel of the Place Grid tab.  After clicking the Line button to create a grid by 

drawing lines, the user can draw the extents of a line that will become a grid line by 

clicking on a start point and an end point.  The only choice on the Options Bar is an 

Offset text box which allows the user to create the grid line offset to the line drawn by a 

specified dimension that is input into the text box.  The Line tool can be used to snap to 

the start and end points of the architectural grid on the background, but this is probably 

not the most efficient way to replicate an architectural grid.  

The Pick Lines button allows a user to select the actual grid line that is being 

viewed on the architectural background, and to create a grid line with the same length 

and location.  After clicking on the Pick Lines button, selecting a grid line from the 

background will automatically create the new grid line.  The Options Bar when the Pick 

Lines tool is being used displays the same Offset text box as when drawing lines.  There 
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is also a Lock check box, which gives the user the additional option to lock the selected 

grid line.  

This option can also be turned on or off after a grid line is created by clicking on 

the lock symbol that is shown near the midpoint of the grid line.  When a particular grid 

line is locked, this means that it cannot be moved relative to the other grid lines in the 

grid system.  This allows the user to move the entire grid system at one time if desired. 

By unlocking the grid line, the user can move a single grid line to a desired location, 

keeping the remaining grid lines at their current locations.  It is recommended to lock 

all grid lines once they are in the appropriate location, and only unlock them if 

individual grid lines need to be moved.

When creating a grid, it is strategically best to begin at the start of the grid 

system, such as at grid line “1” or grid line “A”.  The reason for this is that the 

subsequent lines drawn to create grid lines will be named sequentially after the first 

grid line.  Therefore, if the first grid line created is named grid line “1”, then the second 

grid line created will automatically be named grid line “2”, and so on.  The same is true 

alphabetically.  Therefore, if the first grid line created is named grid line “A”, then the 

second grid line created will automatically be named grid line “B”, and so on.  The grid 

tag for the newly created grid line can be edited by clicking on the new grid bubble.  An 

editing box appears so that the new grid tag can be typed in, and chosen by pushing the 

Enter key.  

Once the desired grid tag is specified, the user can begin drawing the remaining 
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grid lines in the order that they will be named.  If there is an intermediate grid line that 

does not have a whole number name (such as 1.5 or A.5), these lines should be skipped 

until last, so that the whole number grid lines can be created first and named 

automatically.  

After drawing and renaming the grid lines for one direction, the user can edit the 

length of the grid lines by clicking and dragging the start point or end point of the grid 

line.  Note that the default is to automatically modify other grid lines that line up to 

match the new line's length.  This is because the grid line length is locked with the 

others, graphically shown by the lock symbol attached to the grid line start or end point. 

To unlock the grid line so that a single grid line can be edited, the user can click the 

picture of the lock to display in an unlocked position.  Note that this locking ability is 

different from the locking ability that was available on the Options Bar when first 

selecting the line, and the different locks can be accessed based on their location.  The 

locks for the length of the grid line relative to other grid lines appear near the start or 

end of the grid line, whereas the lock that prevents a particular grid line from being 

moved relative to the other grid lines is located near the midpoint of the grid line.  

The option to display or hide a particular grid bubble is available by clicking on 

the check box that appears next to the start or end of the grid line.  This ability can be 

used to switch the side of a grid line from its start to its end, or to show the grid line on 

both sides.  The box will be shown as an empty square on a side where there is no bubble 

being shown.  
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An elbow in the grid line can also be created to avoid grid bubbles overlapping in 

cases where two grid lines may be separated by only a very small distance.  The user can 

do this by clicking on the zigzag line (which looks like a diagonal letter “z”) on the grid 

line near the bubble.  Doing this automatically creates an elbow, which is a kink in the 

end of the grid line.  When that grid line is selected, the solid blue dots at the points of 

the elbow can be dragged to edit the elbow lines.

Figure 10: Grid Line Bubbles, Grid Line 4.9 Shown with Elbow

The changes made to grid lines on one level will not be reflected on all levels 

automatically.  Different levels will have different grid line requirements, and all levels 

may not need the same type of editing.  The user can, however, produce the same grid 

line modifications on multiple levels.  After making the necessary changes to grid lines 

on one level, the user can select the grid lines that were edited and click the Propagate 
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Extents button on the Datum panel of the Modify Grids tab.  This will open a Propagate 

Datum Extents window, where there are check boxes next to the other levels that these 

changes can be applied to.  After marking the desired levels, the user can click OK to 

have the grid line changes be propagated to those levels.  

Adding a Curved Grid

A curved grid that matches areas of curved structure will make it easier for the 

designer to draw and model the curved structure.  The curved grid lines can be selected 

or snapped to when placing curved structural elements.  It is ideal to have an 

architectural background that shows the curved grid, so that it can be snapped to easily. 

If this is not available, the user can create a curved grid line by drawing it.  A curved 

grid line is started the same way as a straight grid, by clicking the Grid button on the 

Datum panel of the Home tab.  To draw a curved grid, the user can employ one of the 

two curved drawing tools, which are the Start-End-Radius Arc and Center-Ends Arc 

buttons.  

The Start-End-Radius Arc tool allows the user to click on the start point of the 

grid line, followed by the end point, followed by a third point which will determine the 

radius of curvature.  This radius can be entered in as a fixed number prior to or while 

drawing the grid line, by typing in the desired dimension into the Radius text box 

available on the Options Bar.  Note that a dimension can only be typed in after placing a 

check in the check box to the left of the word “Radius”.  The specified dimension will 
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only be used if the two points chosen for the start and end points are close enough 

together that it is possible to connect these points with the specified radius.  If not, the 

entry will be ignored, and the user will be able to choose a different radius as if no 

dimension was entered into the Radius text box.  There is also an Offset text box, which 

allows the user to specify a dimension with which to offset the grid line from the chosen 

start, end, and radius points.  Only one of the two Options Bar text boxes can be used at 

one time.

The Center-Ends Arc tool allows the user to click on the center point of the grid 

line radius of curvature first, followed by the grid start point and the grid end point. 

The radius can be entered in ahead of time to restrict the size of the grid line to the 

desired dimension.  This is done in the same place as for the Start-End-Radius Arc tool. 

The Options Bar displays the same available options for both tools.  Like the Start-End-

Radius Arc tool, only one of the two options can be used at one time for the Center-Ends 

Arc tool.   

Figure 11: Created Grid Lines for a Structure
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9. STRUCTURAL COLUMNS

Structural columns typically provide the majority of vertical support for gravity 

loads within a structure.  This means that columns support the beams and floor systems 

that connect to them.  Shear walls also support gravity loads for their respective 

tributary areas, but experience with buildings that have decently large footprints has 

shown that columns account for a larger percentage of the total gravity load.  

Columns can be placed vertically in either plan view or 3D view.  They can be 

placed slanted in either section view, elevation view, or 3D view.  For laying out the 

vertical columns of a floor, it is best to start in the plan view.  Columns can also be 

placed one at a time, or in multiple quantities.  Placing columns at multiple locations 

can be a time saving tool, particularly on projects where there are very many columns 

on each floor.  

One of the ways to model multiple columns at once involves placing columns at 

the intersections of selected grid lines.  Much care must be taken, however, to note 

locations where there are not supposed to be columns at grid line intersections.  The 

columns placed at these locations will need to be deleted or modified as necessary.  It is 

also important to note that the same type or size of column will be placed at all of these 

locations.  This may not seem like a problem in a simplified ideal design, but it is very 

common for column sizes to change along a grid line.  It is also common to have 

column sizes change or terminate at different levels.  Therefore the extents of the 

column, in addition to the type or size and orientation, must be carefully noted when 
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modeling.

While it is ideal to have the same size columns in as many places as possible for 

simplicity of design and construction, this is not always the case because of different 

requirements.  For instance an architect may need a few additional inches of space in 

one direction of a column, but can allow for the extension of the column in the other 

direction.  MEP engineers may request that a column be shifted because of penetrations 

required for mechanical, electrical, or plumbing systems.  Typically almost all columns 

will be assumed to be the same size at the very early onset of a project until more 

detailed information is known as the design of a project progresses.  Only if there are 

known instances of column transfers or other special conditions will a separate column 

size be given at the beginning phase of a project.

Adding Single Columns

When placing columns, it is best to view a floor plan with a background so that 

the horizontal column locations can be chosen.  See the section on LINKING OR 

IMPORTING A DRAWING FILE for information on how to link a drawing.  The user 

can begin adding columns by clicking the Column button on the Structure panel of the 

Home tab.  The type of column can be selected by clicking on the Change Element Type 

drop-down menu, which will display the available column types.  If the desired column 

type is not shown, it can be loaded by clicking the Load Family button on the Detail 

panel of the Place Structural Column tab.  
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The Load Family button opens the Load Family window, in which the user can 

browse through folders to find the desired column family.  The default folder path for 

columns is within the Imperial Library folder, through the Structural folder, followed by 

the Columns folder, then the desired material folder.  A list of column families that fit 

the chosen material will be displayed, and a column family can be selected to open a 

Specify Types window.  Individual column shapes can be selected here to be made 

available on the Change Element Type drop-down menu.  

If a particular column size is not available on the Specify Types window, a new 

type can be created by duplicating an existing type.  This may be necessary for specific 

sizes of concrete columns.  The Duplicate button to copy an existing column type for 

editing is found on the Type Properties window.  This window can be opened by clicking 

on the bottom of the Element Properties button and selecting Type Properties.  Another 

way to open the window is by clicking on the top of the Element Properties button to 

open the Instance Properties window, and then clicking on the Type Properties button 

adjacent to the Type drop-down menu.  

With the Type Properties window open, the user can select the type of column 

that most closely resembles the desired type.  For instance if the user wants to create a 

28” x 28” concrete column, a 24” x 24” concrete square column can be selected here. 

Then the user can click on the Duplicate button, which will open a Name window.  It is 

suggested that the user edits the column name to the desired column type, including 

the material and size in the name.  Now the parameters of the column type can be 
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changed on the Type Properties window to create the desired column type.  To use a 

concrete rectangular column as an example, after entering the new column type name, 

the width (b) and height (h) of the column can be edited on the Type Properties window 

to meet the desired column type.  Clicking OK on the Type Properties window will save 

the column type.  If the user opened the Type Properties window through the Instance 

Properties window, then the Instance Properties window will still be open.  The 

parameters of the column element about to be created can be edited on this window. 

See the Modifying Column Parameters subsection for more information on the Instance 

Properties window for columns.  

Once the desired column type is chosen from the Change Element Type drop-

down menu, the user can begin placing the columns.  To place a single column in plan 

view the user can snap to and click on the desired column location.  After a single 

column is placed, the option to place another column immediately follows.  Also after 

placing a column, the user can rotate it to a different orientation if necessary.  When 

placing a column, the Options Bar displays a number of options including a Tag check 

box, a Rotate After Placement check box, a Depth/Height drop-down menu, a Floor 

drop-down menu, a text box, and (for only concrete columns) a check box for Room 

Bounding. 

Columns that are drawn with the Tag check box on will place the column with a 

tag displaying the column size.  For circular concrete columns, the diameter is 

displayed.  For concrete rectangular columns, the two side dimensions are displayed. 
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For steel columns, the steel member shape designation is displayed.  

When the Rotate After Placement check box is on, the user has the ability to 

rotate the column to a different orientation once the column has been placed. 

Immediately upon placing the column at the desired location, the user is required to 

determine the column's orientation.  There will be the option to place additional 

columns after the rotation is chosen.  Instead of using the Rotate After Placement 

option, there is a quicker way to rotate the column if the desired rotation can be 

referenced by a line in the background drawing.  Pushing the Space bar before clicking 

to place the column will rotate the column to automatically chosen angles based on 

lines in the background drawing.  

The drop-down menus for the Depth/Height and Floor of a column will 

determine on which levels the column will begin and end.  Selecting Depth on the drop-

down menu will give the user the option to indicate (in the adjacent Floor drop-down 

menu) the bottom level that the column will start on, with the current floor being the 

highest level supported.  Selecting Height on the drop-down menu will give the user the 

option to indicate (in the adjacent Floor drop-down menu) the highest level that the 

column will be supporting, with the current floor being the bottom level on which the 

column will start.  Note that depending on which floor the user is drawing the column, 

there are limitations to these drop-down menus.  For instance, when viewing the highest 

level with the Height selection made on the first drop-down menu, the user will not be 

able to enter a different level for the height of the column because the highest level is 
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already being viewed.  The same is true for the lowest level and the Depth selection, 

since the lowest level is already being viewed.  The only option in these cases is to select 

Disconnected, which allows the user to enter a cantilever dimension into the text box to 

the right on the Options Bar.  

The dimension entered will determine the projection of a disconnected (or 

cantilevered) column from the current level.  For instance if on the lowest level with 

Depth and Disconnected selected, and a certain dimension entered, the resulting 

column will be projecting downward from the lowest level by the specified dimension. 

The same is true for the Height and Disconnected selections on the highest floor, which 

would create a column that cantilevers above the highest floor by the indicated 

dimension.  This tool can be used if a column needs to project beyond the highest slab 

level.  

Figure 12: Part of a Column Layout in Plan View
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Adding Multiple Columns

To place multiple columns at once, there is a On Grids button on the Multiple 

panel of the Place Structural Column tab.  The On Grids button allows the user to select 

multiple grid lines in order to place columns at the selected grid line intersections. 

After clicking the Column button on the Structure panel of the Home tab and selecting 

the desired column type from the Change Element Type drop-down menu, the user can 

click the On Grids button to begin selecting grid lines.  The Tag check box when placing 

single vertical columns is still available on the Options Bar, and can be enabled to tag all 

of the columns that will be modeled with the On Grids button.  To select groups of grid 

lines at one time the user can either make a selection box or hold the Ctrl key down 

while clicking on individual grid lines to include them in the same selection set.  Refer 

to the subsection on Selecting Elements within THE REVIT USER INTERFACE section 

for more information on selecting multiple elements to be used in the same selection 

set.  

When the grid lines are selected, a lightly outlined sketch of where the columns 

will be modeled is displayed.  If the sketch shows the desired result, the user can proceed 

by clicking on Finish Selection.  Note that even if a couple of  columns are going to be 

drawn at a location that is not desired, they can be deleted afterward.  Drawing a large 

group of columns at once and then deleting only a few may be less time consuming 

than drawing individual columns for the entire floor.  As mentioned earlier, it is 

important to note which columns will need to be deleted.  The user should use the 3D 
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view to check the columns after modeling.

Another option for adding multiple columns is the At Columns button on the 

Multiple panel of the Place Structural Column tab.  This option presents the ability to 

place structural columns within architectural columns, by snapping to the center point 

of the architectural column.

It is important to note when drawing multiple columns at once that the option to 

input which levels the column will be on is not on the Options Bar as it was when 

drawing individual vertical columns.  The user must edit these parameters by clicking 

the Element Properties button, which is described in more detail below within the 

Modifying Column Parameters subsection.

Figure 13: The Column Instance Properties Window for a Steel Column
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Modifying Column Parameters

After columns have been drawn, they can be selected either individually or in 

groups to view their properties.  After selecting the desired columns, click on the 

Element Properties button on the Element panel of the Modify Structural Columns tab, 

which will open up the Instance Properties window.  If the drop-down menu below the 

button was clicked instead, the same Instance Properties window can be opened by 

clicking on Instance Properties.  This window can be used to modify columns in a few 

ways, including the type and size of the column, the base and top levels of the column, 

and the base and top offsets.  

The type and size can be changed in a similar manner to the way they were first 

selected when originally drawing the columns.  This will eventually be a necessary 

parameter to modify as at least some column sizes are inevitably bound to change 

throughout the course of the project.  The base and top levels of the column will define 

the extents of the column.  The user may find it easier to model the upper and lower 

limits for all of the columns here, as opposed to trying to enter using the Options Bar 

for just the single vertical columns.  The Base Level chosen specifies the lowest level 

that the column will be on, and the Top Level chosen specifies the highest level that the 

column will be supporting.  

The Base Offset and Top Offset allow the user to enter a dimension above or 

below a given level elevation that the column will be cantilevering beyond.  For instance 

if a column is to extend a certain dimension beyond the Roof level, that can be modeled 
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by selecting the Roof as the Top Level, and then entering the desired dimension above 

the Roof as the Top Offset.  Once the editing is completed, the column should be viewed 

in 3D to verify that the desired result was achieved.  

Figure 14: A 3D View of the Structural Column Layout for One Level
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10. STRUCTURAL WALLS

Structural walls can provide a structure with the versatile ability to bear both 

gravity loads and lateral loads.  There are often ideal locations to hide these structural 

walls within thicker architectural partitions, such as around stairwell and elevator shafts 

within a building.  Therefore, the background provided by the architect will be a useful 

and necessary asset in placing the wall.  Similarly to when placing columns, it is best to 

view a floor plan with a background to locate the walls horizontally.  See the section on 

LINKING OR IMPORTING A DRAWING FILE for information on how to link a 

drawing.  Once in the proper view, the user can begin modeling the structural walls.  

Adding Structural Walls

To begin placing a structural wall, the user can click the Wall button on the 

Structure Panel of the Home tab.  Once this is done, the wall can be drawn by using one 

of many options including the  Line, Rectangle, Inscribed Polygon, Circumscribed 

Polygon, Circle, Start-End-Radius Arc, Center-Ends Arc, Tangent End Arc, Fillet Arc, 

Pick Lines, and Pick Faces buttons.  The desired type of wall can be selected by clicking 

the Change Element Type drop-down menu on the Element panel of the Place 

Structural Wall tab.  

If the desired wall type or thickness is not available, the closest option should be 

selected.  The properties of this type can now be edited by clicking on the Element 

Properties button.  This opens the Instance Properties window, where the properties of 
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the wall to be drawn can be edited.  Adjacent to the Type drop-down menu at the top of 

the Instance Properties window, there is the Edit Type button, which allows the user to 

edit the properties of the chosen type of wall or create a new wall type.  To create a new 

wall type by duplicating and editing the properties of the current type being viewed, the 

user can click the Duplicate button, which is adjacent to the Type drop-down menu at 

the top of the Type Properties window.  This opens up a Name window to name the 

duplicated wall type.  It is suggested to make the name as specific as possible so that the 

properties of that wall type will be clear when viewing it on the Change Element Type 

drop-down menu.  At a minimum, the material type and thickness should be included in 

the name.  Once the appropriate name has been entered, the user can click OK to save 

the name of the wall type.  

The Type Properties window will still be open, but now the selection on the Type 

drop-down menu has the name of the new wall type just created.  The properties of this 

new wall type are identical to those of the one type was duplicated, so these properties 

need to be edited.  Clicking on the Edit button adjacent to the Structure parameter will 

allow the user to edit some of the construction properties of the wall type.  This opens 

the Edit Assembly window, where the material and thickness of the wall can input as 

desired, followed by clicking OK.  The function of the wall and some other graphical 

options can be edited here as well, if desired.  After clicking OK on the Type Properties 

window, the Instance Properties window will still remain open.   This window can be 

used to specify the properties of the particular wall element about to be placed.  Also, 
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after a wall has been placed, its properties can still be modified by selecting it, and then 

clicking on the Element Properties button to return to the Instance Properties window.

The Instance Properties window displays parameters such as the Location Line, 

Base Constraint, Base Offset, Top Constraint, Top Offset, Rebar Cover, and options for 

the Analytical Model.  The Location Line drop-down menu will determine which line 

will be used to create the wall.  This drop-down menu is also located on the Options Bar 

when drawing the wall, and is explained in further detail below in the Adding a  

Structural Wall Using Lines subsection.  

The Base Constraint allows the user to select the lowest level that the wall will 

start on, in the same manner as the Base Contraint for column elements.  The Base 

Offset allows the user to create a wall that cantilevers beyond the Base Constraint level 

by the input dimension for this parameter.  The Top Constraint works in the same 

manner as it does for column elements, and determines the highest level supported by 

the wall.  The Top Offset allows the user to create a wall that cantilevers beyond the Top 

Constraint level, in the same way that the Base Offset works for the Base Constraint 

level.  The Rebar Cover is where the user has the option to specify the concrete cover 

dimension from the rebar to the face of the wall, and is only available for walls that are 

made of materials containing rebar, such as concrete or masonry.  

The Analytical Model parameters give the user the ability to manipulate how the 

analytical model appears.  The analytical model can be turned on or off by 

manipulating the Enable Analytical Model check box.  The Horizontal Projection 
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determines where the vertical lines representing the wall in the analytical model will be 

shown along the horizontal axes.  The Top Vertical Projection determines where the 

horizontal line that represents the top of the wall in the analytical model will be shown. 

The Bottom Vertical Projection does the same for the bottom of the wall in the 

analytical model.  The default option for these projections is Auto-Detect, by which 

Revit determines where the intended connection point is made.  The user can change 

this option for the Horizontal Projection to grid lines, or the wall's exterior face, interior 

face, or center-line.  The Top Vertical Projection and Bottom Vertical Projection can be 

changed the top or bottom of the wall, respectively, or either one can be changed to one 

of the levels.  These options are useful if the top or bottom of walls are offset from their 

constraint levels, and the user needs to change the analytical model to match.

Adding Structural Walls Using Lines

To add a structural wall using lines, the user can begin by clicking the Line 

button on the Draw panel of the Place Structural Wall tab.  The Options Bar will show a 

number of options for the wall including the Depth/Height drop-down menu, the Floor 

drop-down menu, a text box, the Location Line drop-down menu, the Chain check box, 

the Offset text box, and the Radius check box with a text box.  

The Depth/Height drop-down menu and Floor drop-down menu serve the same 

purpose as when adding a structural column.  By choosing Depth, the user can select 

the lowest floor that the wall will begin on.  By choosing Height, the user can select the 
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highest floor that will be supported by the wall.  In both cases, the current floor serves 

as the opposite extent.  For Depth, the current floor will be considered the highest floor 

supported by the wall.  For Height, the current floor will be considered the lowest floor 

that the wall will begin on.  If the highest level is being viewed, the Height selection can 

only be used in conjunction with the Disconnected option to specify a cantilevered wall 

that extends beyond the level by the dimension specified in the text box.  The same is 

true for the Depth selection when viewing the lowest level, except the cantilever will be 

extending below the floor in this case. 

The Location Line drop-down menu provides an option for which wall line the 

user wants to draw to model the wall.  The wall line options include the exterior face, 

the interior face, or center-line.  For example, if the user selects Finish Face: Exterior or 

Core Face: Exterior from the menu, the line should be drawn along the exterior face of 

the wall.  With Finish Face: Interior or Core Face: Interior selected, the line should be 

drawn along the interior face of the wall.  It is important to note which direction to draw 

the walls when using these selections. 

When Finish Face: Exterior or Core Face: Exterior is selected, the wall will be 

modeled on the right side of the trace line progress.  To clarify, this means that if the 

user draws the trace line progressing from bottom to top, then the wall will be created 

on the right side of the trace line.  The trace line is the single line that the users draws to 

model the wall, and can be used to trace a line on an architectural background if one is 

loaded.  If the user draws the trace line from top to bottom, then the wall will be on the 
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left side of the trace line.  The opposite is true for Finish Face: Interior or Core Face: 

Interior, in which the wall is modeled on the left side of the trace line progress.   In this 

case, the wall will be modeled on the right side of the trace line if the user draws from 

top to bottom, and on the left side of the trace line if the user draws from bottom to top. 

These details can be confusing to remember, but it is also possible to flip the 

orientation of the wall as the trace line is being drawn.  For instance, after the user clicks 

on the start point to begin tracing the line for the wall, a lightly colored outline of 

where the wall will be modeled is shown.  Before clicking the end point of the wall, the 

user can push the Space key to flip the orientation of the wall to the other side of the 

trace line.  This eliminates the need to worry about which face needs to be drawn in 

which way.  Other options for the Location Line drop-down menu include the Wall 

Centerline and Core Centerline selections.  These options are straightforward in that the 

trace line should be drawn along the center-line of the wall.  

It is ideal to have an architectural background loaded to trace an existing line to 

draw the wall, and to verify that the correct thickness of wall is being used.  The wall 

must meet both structural requirements and architectural constraints, such as 

maximum thickness.  If there is a discrepancy between the two requirements then the 

architect needs to be consulted regarding the thickness of the wall, or the wall will need 

to be redesigned to fit into the space provided if possible.  

The Chain check box option is available to draw multiple walls consecutively. 

When this option is enabled, the endpoint of one wall will automatically be assumed as 
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the start point of the next wall.  This is a useful option when drawing walls that are 

connected, as they might be in a shear wall core.

The Offset text box can be used to draw the wall a specified dimension away from 

the trace line.  Note that the Offset text box can only be used when the Radius check box 

is disabled.  The same rules for wall placement relative to the trace line apply as 

indicated in the Location Line explanation above.  The only additional item to note is 

that when a Centerline selection is made for the Location Line option, the wall is drawn 

offset to the centerline on the left side of the trace line progress.  

Figure 15: A Chain of Structural Walls Being Drawn with an Offset

If the user has the Chain check box on, and draws a wall with an offset, the end 

point of the trace line is not at the same location as the end point of the wall because the 

created wall is offset from the trace line.  Therefore, the start point of the trace line for 
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the next wall in the chain is still the end of the trace line from the previous wall, and the 

new wall will have the specified offset from that point.  If the next wall in the chain is in 

a different direction than the previous wall, then the two walls will not be connecting 

because the new wall will be drawn offset from the new trace line progress.  See Figure  

13 for an example of a wall being drawn with an offset while the chain check box is 

enabled.

Adding Structural Walls Using Rectangles

To add a structural wall using a rectangle, the user can click the Rectangle 

button on the Draw panel of the Place Structural Wall tab.  The Rectangle drawing tool 

allows the user to draw a box of walls, which is essentially four walls connected at the 

corners.  Four trace lines are made simultaneously, which can speed up the process of 

drawing shear wall cores or any wall layouts that have a simple rectangular pattern. 

The Options Bar has the same choices as it does for drawing a wall using lines, with the 

exception that the Chain option is unavailable.  The Location Line selections work in the 

same ways that they do for the lines.  The suggested method for drawing a set of walls 

with the Rectangle tool is to use the centerline intersections of the walls at their corners. 

Adding Structural Walls Using Inscribed Polygons and Circumscribed Polygons

The Inscribed Polygon and Circumscribed Polygon buttons are available for 

walls, but it is unlikely that these shapes will be needed on an actual project.  They 
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perform in a similar manner to the structural slab buttons of the same type, with an 

understanding of the Location Line option as mentioned above.  See the section on 

STRUCTURAL FLOORS  and the subsection of Adding a Structural Floor Using  

Polygons or Circles  for more specific information regarding these tools.  It is 

recommended, however, to draw any walls that may occur in polygon shapes using the 

Line tool.  

Adding Structural Walls Using Circles

If a circular wall pattern is needed, the user can click the Circle button on the 

Draw panel of the Place Structural Wall tab.  The Location Line selection on the Options 

Bar is seemingly irrelevant for this tool, as it is easiest to draw the shape using the 

circle's center point.  The Offset and Radius options work in the same way that they do 

for placing a circular structural slab.  See the section on STRUCTURAL FLOORS and 

the subsection of Adding a Structural Floor Using Polygons or Circles  for more specific 

information regarding these tools.

Adding Curved Structural Walls

Curved structural walls can be modeled using the Start-End-Radius Arc, Center-

Ends Arc, Tangent End Arc, and Fillet Arc.  With an understanding of the way the 

Location Line drop-down menu works, these tools perform in a similar manner to the 

way they do when modeling beams.  Therefore, see the section on BEAMS and the 
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subsection of Adding Curved Beams for more specific information regarding the use of 

these tools.  

Adding Structural Walls Using Pick Lines

The Pick Lines button on the Draw panel of the Place Structural Wall tab allows 

the user to select a line that will be used to model the wall.  The wall will be the same 

length as the chosen line, and will be placed depending on the selection made from the 

Location Line drop-down menu.  Therefore, before picking the centerline of the wall, 

the user should change the Location Line setting to a centerline option.

Figure 16: A 3D View of the Structural Wall Layout for One Level
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11. BEAMS

Beams make up a significant portion of the floor structure for steel buildings. 

They may also provide a large amount of support for concrete buildings that are not flat 

slab construction.  Even with flat slab concrete construction, beams are necessary in 

places where the slab alone cannot support the required loads.  The user can model 

beams by adding a single beam or a network of beams at a time.  Adding a single beam 

span at a time is useful when framing the girders of a floor.  The girders are typically 

considered to be the larger beams connecting the columns of the structure.  Other 

smaller beams frame into these girders to complete the support of the slab.  

The user has the option to add a single span beam, a chain of beams across 

multiple connecting spans, beams in multiple locations along a grid line, or a system of 

beams for an entire bay.  While the methods of adding a single beam at a time are useful 

for particular complex situations, they are not particularly efficient for simplified 

construction that has repetitive framing bays.  In this case, it would be a tedious process 

to model each beam individually for every beam on a given floor of a project when 

many of them will be the same.  A structural engineer will have an idea of how to frame 

out the floor system prior to attempting to model the beams, so the best method of 

drawing the beams should be determined then.  Typically the controlling factor in the 

layout of a framing plan is the maximum span of the structural floor.  If the desired slab 

on metal deck can only span a certain distance, then beams will need to be placed at a 

spacing no greater than that maximum distance.  Depending on the project geometry, a 
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typical layout of beams may be used repeatedly in multiple bays of a given floor.  In this 

case, the ability to add a system of beams is very useful.  In other projects, the geometry 

may be so irregular that adding a system of beams is not practical.  

Modeling beams can be done in either the plan view or 3D view.   The grid line 

option is not available, however, in the 3D view since grid lines are not visible in the 3D 

view.  It is recommended to do all beam drawing in plan view for simplicity and to focus 

on the framing for the current floor.  In order to add beams in the 3D view as 

mentioned above, the user can enable the 3D Snapping check box on the Options Bar for 

many of the drawing buttons on the Draw panel of the Place Beam tab.  Turning this box 

on allows the user to snap to a location along the length of elements.  This is generally 

not suggested, however, since it is difficult to place the beams accurately in the 3D view. 

The 3D view should generally only be used after drawing the beams to check that they 

were placed as intended.  

Adding a Single Span Straight Beam

To begin adding a single span beam, the user can click the Beam button on the 

Structure panel of the Home tab.  This initiates the Place Beam tab, on which the user 

can select the material, cross-sectional shape, and size of beam to model.  These 

parameters can be chosen from the Change Element Type drop-down menu on the 

Element panel of the Place Beam tab.  If the desired beam type is not displayed on the 

drop-down menu, the user can load it to make it available.  To load a beam type, the user 
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can click the Load Family button on the Detail panel of the Place Beam tab.  This opens 

the Load Family window through which the user can browse for the desired beam 

family.  The folder path from the Imperial Library folder is through the Structural and 

Framing subfolders, where the user can then open the desired material folder.  The list 

of files in the material folder are the families available for the user to load.  After 

clicking on the desired family file, a Specify Types window will open so the user can 

select which particular types from that family will be loaded.  This step is skipped if the 

family is made up very few types, in which case all of the types will be automatically 

loaded.  

If the desired type is not on the Specify Types window, as may be the case for a 

concrete beam of particular dimensions, a new type can be created by duplicating an 

existing type.  The Duplicate button to copy an existing beam type for editing is found 

on the Type Properties window.  The user can open this window by clicking on the 

bottom of the Element Properties button and selecting Type Properties.  Another way to 

open the window is by clicking the top of the Element Properties button to open the 

Instance Properties window, where the user can click the Type Properties button 

adjacent to the Type drop-down menu.  

With the Type Properties window open, the user can select the type of beam that 

most closely resembles the desired type.  For instance if the user wants to create a 12” x 

30” concrete beam, a 12” x 24” concrete rectangular beam can be selected here.  Then 

the user can click the Duplicate button, which will open a Name window.  It is suggested 
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that the user edits the name to the desired beam type, including the material and size in 

the name.  Now the parameters of the beam type can be changed on the Type Properties 

window to create the desired beam type.  To use a concrete beam as an example, after 

entering the new beam type name, the width (b) and height (h) of the beam can be 

edited on the Type Properties window to meet the desired beam type.  Clicking OK on 

the Type Properties window will save the beam type.  If the user opened the Type 

Properties window through the Instance Properties window, then the Instance Properties 

window will still be open, where the parameters of the beam element about to be 

created can be edited.  The window includes parameters such as the beam elevation 

relative to its referenced level.  See the Editing a Beam Elevation and the Beam Instance  

Properties Window subsection for more information on the Instance Properties window.

Once the desired beam type is chosen from the Change Element Type drop-down 

menu, the user can draw the shape of the beam span by using the tools on the Draw 

panel of the Place Beam tab.  The basic span shape that can be drawn is either a straight 

linear span or a curved span.  To add a single linear beam the user can click on the Line 

button to create the beam in the model by clicking on the desired location for the beam 

starting point and then clicking again on the desired beam ending point.  Once this is 

completed, the user can place additional beams of the same type in other locations by 

clicking a new starting and ending point.  The user can also use the Pick Lines button to 

select an existing line, which will create a beam along this line with the same starting 

and ending point as the line.  This is useful if a background drawing has lines already 
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drawn where the beams will go, but it is generally recommended that the structural 

engineer draws all of the beams themselves.  

Adding a Single Span Curved Beam

There are multiple ways to draw a curved beam.  The recommended way to draw 

a curved beam is to have drawn a curved grid first that can be snapped to when drawing 

the curved beam.  See the GRID SYSTEMS section and specifically the Creating a  

Curved Grid subsection for more information on curved grids.  One way to draw a 

curved beam is by clicking the Start-End-Radius Arc button on the Draw panel of the 

Place Beam tab.   With this tool, the user can click the starting point of the beam, the 

ending point of the beam, and a point along the desired radius of curvature.  If a curved 

grid was created, the point along the desired radius of curvature would be a point along 

the curved grid.  

If a curved grid is not available, however, the user can manually select the radius 

of curvature by using the temporary dimension shown while selecting the third point of 

the beam.  The user can also enter the radius prior to drawing the beam, by clicking the 

Radius check box on the Options Bar for the Start-End-Radius Arc button, and then 

typing in the desired value.  This will restrict the radius of curvature to the specified 

dimension if the start and end points are an appropriate distance away from each other 

such that it is possible to create a beam with the specified radius.  If not, the entered 

dimension will be ignored.
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Another option for modeling a curved beam is the Center-Ends Arc button.  With 

this tool, the user can first select the center point for where the radius of curvature will 

be taken from, followed by the start and end points for the beam.  The Radius option on 

the Options Bar can also be used with this tool if the Radius check box is turned on.  In 

this case, after specifying the desired radius and clicking the center point of the radius 

of curvature, the user is restricted to picking the start and end points of the beam along 

a circle of the specified radius.  

The Tangent End Arc button is another way to model a curved beam.  In this 

case, the user can first select the start point for the beam, followed by the end point, and 

a determined radius will be automatically chosen.  A radius can be entered on the 

Options Bar, as it was for the previously mentioned curved beam tools, allowing the user 

to specify a particular radius of curvature.  This will, however, restrict the locations that 

the user can choose for the end point of the beam since only certain locations will 

satisfy the radius requirement.  Using the Radius option will force the user to choose an 

end point location that is along a circle of the specified radius.  With the Tangent End 

Arc tool, the circle location is determined by the start point of the circle, and not the 

center point of the circle as it was for the Center-Ends Arc tool.  

The Fillet Arc tool allows the user to create a curved beam at a corner where two 

beams intersect.  First the user can click on one beam that forms the corner, followed by 

the other beam that forms the corner.  The user will now be able to draw a curved beam 

that intersects these two beams.  The radius that is chosen will determine the point at 
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which the curved corner beam will intersect the other beams, and the other beams will 

be shortened as required.  This creates a situation where the first beam will end at a 

particular point, from which the curved beam will begin, until it intersects the other 

beam, at which point the curved beam will terminate and the other beam will begin. 

The same Options Bar choices that were available for the other curved drawing tools are 

also available for the Fillet Arc tool.  

The Spline tool allows the user to create a beam with multiple curves along one 

span, by selecting control points for the curves of the beam.  The user can first enter the 

spline beam start point, followed by control points for the beam until the desired beam 

is displayed, when the user can push the Esc key to create the beam.  The control points 

are points that form a zigzagged line that begins at the start point.  The spline beam is 

created by forming curved portions that are tangent to these zigzagged lines.

Adding a Chain of Beams

The user can add a chain of beams across multiple connecting spans by clicking 

the Chain box on the Options Bar for many of the drawing tool buttons on the Draw 

panel of the Place Beam tab.  After clicking the locations of the required points for the 

first beam, Revit assumes that the specified end point is the start point of the next beam 

in the chain.  This allows the user to skip the step of having to click the required next 

beam's start point if it can be assumed that it is just the previous beam's end point.  

For example when creating a beam using the Line button, immediately upon 
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clicking on the end point of the beam, a new beam is initiated with this end point being 

the new beam's start point.  When creating a beam using the Start-End-Radius Arc 

button, immediately upon clicking on the point along the radius of the curved beam, a 

new beam is initiated with the end point of the previous beam being the next start point. 

Note that the end point is the second click that was performed, and not the third click 

which determined the radius of the curve.  

Many of the other beam drawing tools also include the Chain check box on the 

Options Bar, with the exceptions of the Center-Ends Arc, Fillet Arc, and Pick Lines 

buttons.  The ability to draw a chain of beams is particularly useful when modeling a 

number of straight beams that are connected at their ends.  Upon drawing the first 

beam the user can click consecutive endpoints until the chain of beams is completed.  It 

will also save time if there are a number of adjacent curved beams that are connected at 

their ends.  

Adding Multiple Beams Using the On-Grids Button

Another option for drawing beams in a model is to use the On Grids button on 

the Multiple panel of the Place Beam tab.  After clicking the On Grids button, the user 

can click on a grid line in the model, which will show where beams will be placed based 

upon the supports that are available along that grid line.  See the subsection on 

Selecting Elements in THE REVIT USER INTERFACE section for suggestions on how to 

select multiple grid lines.  Once the desired beams are displayed on the selected grid 
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lines, the user can click the Finish Selection button on the Multiple Selection panel of 

the Place Beam > On Grid Lines tab to create the displayed beams.

Figure 17: A 3D View of the Beam Framing Layout for One Level

Adding a Beam System

The Beam System tool only creates the beams within a framing bay, and not the 

girders.  To begin creating a beam system, the user can click the Beam System button 

on the Structure panel of the Home tab.  This places the view in a sketch mode and 

opens the Create Beam System Boundary tab.  The user can choose how to draw the 

beam system and adjust the properties of the beam system on this tab.  The beam 

system is created by first drawing a boundary within which the beams of the system will 

be placed.  Before drawing the boundary, the setting must be on Boundary Line on the 
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Draw panel of the Create Beam System Boundary tab.  The user can use the available 

drawing tools on the Draw panel to create the beam system boundary.

Many projects' geometry will be limited to bays that can be drawn with the Line 

or Rectangle drawing tools.  For the Line tool, the user can click on start and end points 

for individual lines to make up the boundary of the beam system.  With the Rectangle 

tool, the user can click on the starting corner and ending corner of a rectangle that will 

form the boundary of the beam system.  All of the drawing tools work in a similar 

manner to the way they do when creating a boundary for a floor system.  See the section 

on STRUCTURAL FLOORS and particularly the individual subsections on each drawing 

tool for more information about the tools and their us.  

After drawing the desired beam system boundary, the user can choose the 

direction in which the beams of the system will be spanning.  To do this, the user can 

change the setting from Boundary Line to Beam Direction by clicking on the Beam 

Direction button on the Draw panel of the Create Beam System Boundary tab.  A default 

direction was already chosen when the beam system boundary was created, and the 

beam direction is represented by the two lines that are parallel to and on either side of 

one of the beam system boundary lines.  If these lines are spanning in the desired 

direction, no action needs to be taken to change the direction.  To change the direction, 

the user can select an edge or line from the boundary to use as the new beam direction 

if the Pick Lines tool on the Draw panel is selected.  The other option is to use the Line 

tool of the Draw panel to draw a line in the desired direction for the beams to span.
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With the beam system boundary defined and the direction chosen, the properties 

of the beam system can be modified.  The user can click on the Beam System Properties 

on the Element panel of the Place Beam System tab to open the Instance Properties 

window for the beam system.  From this window, the user can enter the beam system 

elevation, and choose the rules for how the beams in the system will be laid out, the type 

of beam that will be used, and the level on which the beams will be tagged.  

The Elevation parameter works the same way as the z-Direction Offset Value 

parameter for beams, which determines the relative elevation to the chosen work plane. 

Be sure to verify that the work plane shown is the desired level.  If it is not, the user can 

go to the desired plan view in the Project Browser.  The use can exit the window by 

clicking Cancel, and then exit the command by clicking on the Cancel Beam System 

button on the Beam System panel of the Place Beam System tab.  Now the user can go to 

the desired plan view in the Project Browser, and click the Beam System button again. 

By clicking on the Beam System Properties button, the user can check that the work 

plane now matches the desired level, and can begin specifying the remaining 

parameters for the beam system.  

The Justification of the beam system determines how the beams of the system 

will be justified.  For instance, the default is Center, which means that the beams will be 

placed equally spaced from the sides of the boundary.  Choosing Beginning or End 

instead will justify the beams to one side, with the side chosen having the same spacing 

as the beam spacing.  Depending on the Layout Rule and dimension specified to govern 
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the beam spacing, the other side will have the distance that is remaining between the 

last or first beam and the boundary.  Note that the number of beams and/or spacing of 

beams will be affected by the Justification chosen.  

The Layout Rule determines how the beams in the system are spaced.  As 

previously mentioned, the governing factor for beam spacing is usually the span of the 

floor type.  If this is the case, the user can choose Maximum Spacing for the Layout 

Rule, which will limit the spacing of the beams to the dimension specified in the value 

box adjacent to the Maximum Spacing parameter.  This parameter will determine the 

minimum number of beams required to meet the maximum spacing specified, and will 

space the beams accordingly.  Another option for the Layout Rule is Fixed Number, 

which allows the user to enter a set number of beams that will be equally spaced within 

the boundary lines.  The same spacing that separates the beams will also be used 

between the boundary line parallel to the beam direction and the first or last beam in 

the system.

A third Layout Rule option is Fixed Distance.  This rule places the beams at a 

specified spacing away from each other, using as many beams as required to fill the 

beam system boundary.  The spacing can be specified in the box next to the Fixed 

Spacing parameter.  The last option for the Layout Rule is Clear Spacing.  This rule will 

place the beams according to a specified dimension using the edge of the beam rather 

than the beam center-line for the spacing.  The Clear Spacing dimension entered will be 

the clear distance between adjacent beams.
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The Beam Type is another parameter that can be selected on the Instance 

Properties window.  This drop-down displays all of the available beam types that were 

loaded or created.  If the desired beam is not available, it can be loaded or created from 

the Place Beam tab by using the Load Family button or accessing the Type Properties 

window.  See the Adding a Single Span Straight Beam subsection for information 

regarding how to load or create new beam types.  Verify that the Tag New Members In 

View parameter on the Instance Properties window matches the work plane level, so that 

the beams are tagged in the proper view.  This parameter can be edited to match the 

work plane if necessary.  

After all of the desired parameters for the beam system have been chosen on the 

Instance Properties window, the user can click OK to save these properties.  Now that the 

beam system boundary has been drawn, the beam system direction has been chosen, 

and the beam system properties have been set, the user can model the beam system by 

clicking on the Finish Beam System button on the Beam System panel of the Create 

Beam System Boundary tab.  After the beam system has been modeled, it is 

recommended that the user verify that the beams were placed as intended by viewing 

the plan view of the beam system, and then checking the 3D view.  

If the beam system needs to modified, individual beams or the entire system can 

be selected for editing.  Select an individual beam by clicking on the outline of the 

beam, which will light up in purple when the mouse arrow is over the beam.  To select 

the entire beam system, the user can move the mouse arrow to one of the beam center-
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lines, which should light up the entire beam system center-line with purple dashed lines. 

The user can click on the purple dashed lines to select the entire beam system.  See THE 

REVIT USER INTERFACE section and Selecting Elements subsection for additional 

information about selecting elements.  With the beam or system selected, the user can 

click modify the beam or beam system from the respective Modify Structural Framing 

or Modify Structural Beam System tabs.

Figure 18: A 3D View of a Beam System

Editing a Beam Elevation and the Beam Instance Properties Window

After drawing a beam, the user can edit the elevation of a beam relative to its 

level elevation.  Some reasons for doing this would be to account for the thickness of the 

concrete slab for floors consisting of steel framing, or for areas where there is a slab 
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drop to accommodate a different architectural floor system.  There are two ways in 

which a beam's elevation can be offset from its floor level.  Both ways are on the 

Instance Properties window of the beam.  After  selecting the beam or group of beams, 

the user can click the Element Properties button on the Element panel of the Modify 

Structural Framing tab.  This will open the Instance Properties window.  

The first method to modify the beam elevation is by changing the z-Direction 

Justification to Other, which allows the user to specify a z-Direction Offset Value.  This 

value will offset the elevation of the selected beams relative to the floor level elevation. 

Note that the default condition is that the z-direction is the vertical axis, and that 

positive is up.  Therefore, in order to offset the top of beam elevation lower, the user can 

enter the z-Direction Offset Value as a negative dimension.

Another method to modify the beam elevation is by changing the Start Level 

Offset and End Level Offset in the Instance Properties window.  By entering the same 

value into both parameters, the beam will be raised or lowered by the same dimension. 

This ability also allows the user to slope the beam by entering a different value for the 

Start Level Offset than the End Level Offset.  This may is useful for when the architect 

requires a sloped structure, such as for roofs or any structure that requires drainage by 

gravity.  By sloping the structure a small amount, the force of gravity will bring liquid 

towards the drain.  If the drain is in the middle of the floor or room, this slope could be 

resolved by only creating a small amount of slope in the concrete topping.  There are 

instances, however, such as on a rooftop play yard, where the entire framing may need 
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to be sloped in one direction towards a larger trench drain.

Another parameter on the Instance Properties window that is of interest to the 

user is the material of the beam.  The material can be changed by clicking on the value 

box adjacent to the Beam Material parameter, and then clicking on the ellipsis (…) 

button.  This button will open the Material window with a list of all of the available 

material types.  The user should become familiarized with the Instance Properties 

window for the different types of beams (and other elements) to learn the parameters 

that can be modified there. 

Adding a Truss

Trusses are a possible solution for structures that require very long spans to 

create large open spaces, such as gymnasiums.  A truss is modeled similarly to a beam 

in Revit.  To begin modeling a truss, the user can click the Truss button on the Structure 

panel of the Home tab.  The user can select the desired type of truss by clicking on the 

Change Element Type drop-down menu, which offers the loaded types of trusses that 

are available, such as a Pratt Truss or Howe Flat Truss.  If the desired truss is not listed, 

the user can load the other truss families that are available in the program by using the 

Load Family button on the Detail panel of the Place Truss tab.  See the Adding a Single  

Span Straight Beam for more information on loading a family.  In this case, truss 

families can be loaded, as opposed to framing families.

If the desired truss is also not available through the Load Family button, a truss 
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type can also be duplicated and edited to create a new truss type on the Type Properties 

window.  The user can open the Type Properties window by clicking on the bottom 

portion of the Element Properties button on the Element panel of the Place Truss tab, 

and then selecting Type Properties.  On the Type Properties, the user can change the 

parameters of a truss type.  The user can also create a copy of a truss type to edit by 

clicking on the Duplicate button.  After naming the new truss type, the parameters of 

the new truss type can be specified in the Type Properties window.  The parameters can 

be specified for either new truss types or existing truss types prior to drawing the truss. 

These include the Structural Framing Type for the Top Chord, Bottom Chord, Vertical 

Web, and Diagonal Web.  The user can also edit these member sizes by clicking on the 

individual members of the truss after it is created.  

Figure 19: The Type Properties Window for a Truss
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After the type of truss is selected, the user can either draw lines or select lines to 

model the truss.  To model by drawing lines, the user can click the Line button on the 

Draw panel of the Place Truss tab.  Similarly to when drawing a beam span, the user can 

click on a start point to begin the span of the truss, and an end point to end the span of 

the truss.  The other option of modeling the truss by selecting lines is initiated by 

clicking the Pick Lines button on the Draw panel of the Place Truss tab.  The user can 

select a line to use as the truss span.  If a line is not already drawn to meet the desired 

truss span, this tool is not as useful as drawing lines to create the truss.  With either tool, 

however, a line that is longer or shorter than the desired truss span can be selected and 

shortened or elongated to meet the required truss span.  This is done by clicking and 

dragging the solid blue dots that are at the ends of the truss to the desired start point 

and end point.  It is generally recommended to draw lines to create the truss with the 

Line tool, as this typically requires the least amount of steps.  The Pick Lines tool will 

only be quicker if a line that has the desired truss span is already available and can be 

selected.  

The Options Bar for the two different tools are similar.  Both have a Placement 

Plane drop-down menu and a Tag check box.  The Placement Plane drop-down menu 

works in the same way as it does for a beam.  The user can select which level to place 

the top of the truss, regardless of whether or not that level is currently being viewed. 

The Tag check box is on by default, which means that a rectangular box that can be 

used to name the truss will appear adjacent to the truss.  This box will not appear if the 
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Tag check box option is disabled.  To enter information in the box, the user can click on 

the perimeter of the box to select it, and then click on the interior of the box to enter the 

name of the truss.  

Two options that differ between which tool is used to create the truss are the 

Chain check box and Lock check box.  The Chain check box only appears when creating 

a truss by drawing lines with the Line button.  When the Chain check box is enabled, it 

allows the user to draw a connected chain of trusses, with the last end point clicked 

automatically becoming the start point of the next truss.  The Lock check box only 

appears when creating a truss by selecting lines with the Pick Lines button.  The Lock 

check box functions similarly to the way it does when selecting lines for creating a grid. 

If the check box is on, the selected line is locked and cannot by dragged to a new 

location separately from the rest of the structure.  If the check box is off, then the line is 

unlocked and can be dragged independently from the surrounding structure.  The two 

lock conditions are displayed by a picture of a lock at the midspan of the line in either 

the locked or unlocked position.

It is suggested that the user set up a framing elevation to view the truss in 

elevation for modifying and checking.  This can be done by clicking on the bottom 

portion of the Elevation button on the Create panel of the View tab.  The user can place 

a framing elevation symbol by clicking on a reference plane such as a grid line.  This 

symbol will determine the direction for the elevation view.  When the framing elevation 

symbol is placed, a framing elevation view will be added to the Project Browser under 
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the category of Elevations (Framing Elevation).  

The parameters of a truss can be modified by accessing the Instance Properties 

window.  The user can click on the truss to select it, and then click the Element 

Properties button on the Element panel of the Modify Structural Trusses tab.  The 

Instance Properties window displays a large amount of information for the truss, 

including the Start Level Offset and End Level Offset, the Bearing Chord, the Truss 

Height, and Max Panel Width among others.  The user can change these parameters to 

meet the desired truss design.  It is recommended that the truss is viewed in either the 

3D view or the elevation view when modifying its parameters.  

The Start Level Offset and End Level Offset offer the user the ability to raise or 

lower the elevation of the truss relative to the level elevation.  This parameter can be 

used to allow space for the structural slab and architectural floor construction that will 

supported by the truss.  The Bearing Chord setting determines whether the top chord or 

the bottom chord of the truss will be used to bear on the support members.  Note that 

the default Bearing Chord selection is the Bottom Chord, which means that the truss 

will be modeled with the bottom chord at the selected level.  Switching the Bearing 

Chord selection to Top Chord will model the truss with the top chord at the selected 

level.  This option should match the intended bearing connection for the actual truss.  If 

Bottom Chord is selected for the Bearing Chord parameter, the truss can still be 

modeled graphically with the top chord in plane with the rest of the framing for that 

level by modifying the Start Level Offset and End Level Offset appropriately.  
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The Truss Height is the dimension from the center-line of the top chord of the 

truss to the center-line of the bottom chord of the truss.  This parameter is important to 

note when designing and modeling the truss to meet architectural height restrictions. 

For instance, if the truss is required over a gymnasium, the architect will require a 

certain amount of clearance below the truss for activities such as playing basketball. 

The structural engineer must consider the fact that the Truss Height parameter entered 

into Revit does not include the dimension from the center-line of the chords to the top 

or bottom of the chord members.  

The Max Panel Width allows the user to change the number of panels of the truss 

by giving maximum dimensions to the panel width.  Note that there are limitations to 

the number of panels this parameter allows.  The user can, however, select individual 

truss members to modify their geometry by unpinning them.  This is done by clicking 

on the pin graphic that appears next to the selected member.  These truss components 

can then be stretched or shortened and moved around to obtain the desired truss.

It is also important to note that the depending on the truss type selected, vertical 

truss members may be modeled at the support points.  These vertical members may be 

necessary if the truss is being supported by beams, but that is an unlikely structural 

situation.  The truss is more likely to be supported by vertical elements such as columns, 

in which case these end vertical truss members are unnecessary and need to be deleted. 

The user can do this by clicking on the truss member to select it.  It is recommended to 

view the truss in 3D to delete these members.  The user should be sure to select only the 
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vertical truss member to be deleted and not the entire truss.  The entire truss will be 

selected if a dashed outline of the truss member center-lines is shown when the mouse 

arrow is over the element about the be clicked.  An outline of just a single truss member 

will be shown if only that member will be selected.  The user can try placing the mouse 

arrow over the edges of a single member to select only the truss member as opposed to 

the entire truss.  In order to select the entire truss, it is recommended that the user tries 

placing the mouse arrow over a point where truss members intersect.  The user can 

check the outline shown as a guide before making the selection.  See THE REVIT USER 

INTERFACE section and the Selecting Elements subsection for suggestions on selecting 

elements. 

Figure 20:  Elevation of A Truss
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12. BRACES

Braces are generally diagonal structural members, typically made of steel, that 

are used to withstand lateral loads.  Like shear walls in concrete buildings, braces are 

usually part of a steel structure's lateral system that will carry the lateral load between 

different levels of a structure in order to bring the load to the foundation.  Depending 

on the structures that they are a part of, braces are found in both large and small sizes. 

Braces are commonly used in structures ranging from incredibly tall steel skyscrapers 

to simple small dunnages for mechanical equipment.  The ideal view to add braces to a 

structure is either an elevation view of the exterior of the structure, or a section view 

that allows the user to see an elevation of the interior of the structure.  

Adding Braces

After the ideal view is set to model the brace, the user can click on the Brace 

button on the Structure panel of the Home tab.  The first time this is done for a given 

view, it automatically opens up a Work Plane window.  With this window, the user can 

specify a work plane for the brace by selecting a grid line or level from the drop-down 

menu adjacent to the Name option.  This is the suggested method to specify a work 

plane.  

It is also possible to use the Pick A Plane option, which after clicking OK, allows 

the user to click on a line in the model to use as a reference plane.  This is useful if the 

user needs to pick a plane that is not an existing grid line.  The views must be switched, 
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however, from different sides of the elevation when selecting the plane and when 

drawing the brace.  For instance, the view when selecting a plane should be 

perpendicular to the plane that the brace will be drawn in.  If the work plane needs to be 

respecified, the user can open a new Work Plane window by creating a new section and 

clicking on the Brace button in the new section view.  

After the work plane is specified, the member type should be selected prior to 

drawing the brace.  The user can access the currently loaded members by clicking on 

the Change Element Type drop-down menu on the Element panel of the Place Brace tab. 

This list of members will be the same list that was available when placing beams into 

the model.  Therefore, the user can follow the same procedure for loading new 

members.  See the BEAMS section and the Adding a Single Span Straight Beam 

subsection for information regarding creating or loading framing types.  

With the desired type selected, the user can draw the brace with the only tool 

available, which is the Line button on the Draw panel of the Place Brace tab.  The user 

can snap to the desired start point and end point for the line.  Although it should be 

done after modeling all types of elements, it is particularly important to view braces in 

the 3D view.  

If the brace does not appear as desired, it can be modified.  The first step is to 

select the brace by clicking on it.  With the brace selected, the Modify Structural 

Framing tab opens up with ways that the user can modify the brace.  The member type 

can be changed by clicking on the Change Element Type drop-down menu, and 
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selecting the desired type.  The brace can also be moved, copied, rotated, mirrored, 

arrayed, pinned or deleted, with the options on the Modify panel.  If the start or end 

points of the brace need to be adjusted, the user can modify these points by clicking and 

dragging the solid blue dots that appear at the brace's ends.  Other parameters of the 

brace can be edited by opening the Instance Properties window, which can be accessed 

by clicking the Element Properties button on the Element panel of the Modify 

Structural Framing tab.  These parameters will be similar to those for beams, since both 

are considered structural framing.  See the section on BEAMS for more information 

regarding the Instance Properties window for structural framing elements.  

Figure 21: Brace Layout for One Level
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13. STRUCTURAL FLOORS

It is recommended when drawing the outline of a structural floor to have a 

background indicating the architect's required edge of slab.  An architect will often issue 

slab edge drawings as a separate series of plan drawings to clearly show all of the 

dimensions and required information to build the extents of the slab.  The suggested 

view to draw structural floors is the plan view.  After importing an architectural 

background and adjusting the necessary visual options to view it properly, the user can 

begin to draw the boundary of the structural floor by snapping to the architectural 

background in the appropriate locations.  See the section on LINKING/IMPORTING A 

DRAWING FILE and the subsection on Linking or Importing a CAD Drawing for 

information on loading an architectural background.  

In certain buildings, different levels of the structure will often have similar or 

even identical structural floor types and boundaries.  After one floor is modeled, it may 

be more efficient for the user to copy this floor to other similar levels, rather than 

creating a new structural floor for every level.  The floor type and See the Adding a  

Foundation Slab By Copying A Floor Above subsection of the STRUCTURAL 

FOUNDATIONS section for information on how to copy and edit a structural floor from 

one level to another.

Adding a Structural Floor

To start drawing the structural floor, the user can click on the Floor button on the 

99



Structure panel of the Home tab.  This places the model in a sketching mode, where the 

user can begin outlining the extents of the slab.  The sketch mode allows the user to 

create a floor boundary, and modify this boundary before modeling the floor.  Prior to 

drawing the floor boundary, the user should input the desired floor type on the Instance 

Properties window.  This window is opened by clicking on the Floor Properties button of 

the Element panel on the Create Floor Boundary tab.  The user can select the type of 

floor here, along with which level it will be applied to, the height offset from the level, if 

the floor is a structural floor, and other properties.

If the desired floor is not available, it can be created.  To do this, the user can 

select the floor type from the Type drop-down menu that most closely resembles the 

desired floor.  Now the user can click on the Edit Type button, adjacent to the drop-down 

menu.  After the Type Properties window opens, the user can edit or duplicate a floor 

type to create a new one.  By clicking the Duplicate button, the user can make a copy of 

the selected floor type for editing.  This immediately opens a Name window in which 

the user can enter the name of the new floor type.  It is suggested that the name 

includes as much information as possible to easily identify the floor type later on in the 

drop-down menus.  The floor thickness and material are recommended details to 

include.  For instance, if the floor is a concrete slab on metal deck, then both the 

thickness of the concrete topping and the thickness of the metal deck can be included in 

the name.  After clicking OK to save the entered name, the Type Properties window will 

show the new floor type name with the old floor type properties.  The user can edit the 
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structure of the floor system by clicking the Edit button adjacent to the Structure 

parameter.  When the Edit Assembly window opens, the user can specify the thickness of 

the concrete and the thickness of the metal deck.  To save these changes and the new 

floor type, the user can click OK on both the Edit Assembly window and the Type 

Properties window.

The Instance Properties window allows the user to edit some of the floor 

parameters for the floor element that will be drawn.  The user can select the Level that 

the floor will be created on.  The user can also enter the Height Offset From Level, to 

change the elevation of the slab relative to the elevation of the level.  This parameter is 

useful when different areas of the floor are at different elevations.  A slab depression 

could be required for different types of architectural flooring materials.  Certain types 

of tiles, dance floor systems, and other architectural flooring systems require a deeper 

amount of space, resulting in a need for a depression in the structural slab to keep the 

finished floor at the correct elevation.  

Other parameters that can be changed through the Instance Properties window 

include the Structural, Rebar Cover, and Analytical Model settings.  The Structural 

determines whether or not the floor is a structural element.  All of the floors created in 

Revit Structure by the structural engineer are most likely going to be structural 

elements.  The Rebar Cover allows the user to input the concrete cover to the slab 

reinforcement.  The Analytical Model parameter of Vertical Projection determines 

where the lines that represent the floor in the analytical model will be shown.  It is 
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recommended to just leave the Auto-Detect option for this parameter.

Once the desired floor type is selected and its are parameters edited, the user can 

begin to draw the floor boundary by clicking on one of the buttons of the Draw panel on 

the Create Floor Boundary tab.  Note that the Boundary Line button must be selected in 

order to draw the floor boundary.  When the user has Boundary Line selected, the lines 

drawn will be an outline of the floor, and the space within these drawn boundaries will 

make up the structural floor. 

If there are multiple floor types or a slab depression on a particular level, it is 

suggested that the user treats these different floor elements.  Therefore, the user can 

draw a boundary around the different floor types or the slab depression to exclude from 

the other floor elements.  When a completed boundary of lines is made within another 

boundary of lines, the area within the interior boundary will be excluded from the 

exterior boundary area.  If necessary, the user can switch between the drawing tools 

while in the sketch mode to draw different slab edge shapes.  See the subsections below 

for information on the individual drawing tools found on the Draw panel.

Figure 22: The 3D View of a Slab Depression Within a Structural Floor
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Adding a Structural Floor Using Lines

The user can being by clicking on the Line button on the Draw panel of the 

Create Floor Boundary tab.  Openings in the middle of the slab for items such as 

elevators, stairs, or mechanical equipment can be drawn in later.  Therefore the user can 

disregard opening elements at this point in time.  See the Adding a One Floor Vertical  

Opening and Adding a One or Multiple Floor Shaft Opening subsections of the 

OPENINGS section for information regarding modeling opening elements in structural 

floors.  After the Line button is clicked, the user can begin drawing the floor boundary 

by clicking on points along the boundary.  If an architectural background is loaded, the 

user can snap to points on the background to trace the edge of slab.  

  

Adding A Structural Floor Using Rectangles

If the slab shape is as simple as a plain rectangle, the user can draw the floor 

boundary using the Rectangle button.  This tool allows the user to draw a rectangular 

boundary by clicking two of the diagonal points that form the corners of the rectangle. 

Adding a Curved Portion of a Structural Floor

If the architectural background is showing a curved slab edge, the user can 

accommodate this by using some of the drawing buttons on the Draw panel to match 

the curve.  These buttons include Center-Ends Arc, Tangent End Arc, Fillet Arc, and 

Spline.  See the Adding a Single Span Curved Beam subsection of the ADDING BEAMS 
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section for information on using these drawing tools.  

 

Adding a Structural Floor Using Polygons or Circles

The Inscribed Polygon, Circumscribed Polygon, and Circle buttons allow the user 

to draw either a polygon with a specified number of sides, or a circle.  First, the user can 

click on the center point of where they would like the polygon or circle placed, and then 

can enter the desired number of Sides (only for a polygon), Offset, or Radius (only after 

enabling the Radius check box).  These options are found on the Options Bar after the 

user has clicked on one of these drawing buttons.  The Offset option will allow the user 

to draw the polygon or circle beyond the point clicked to determine the size of the 

radius.  This is useful if the user needs to draw an element beyond the farthest snapping 

point available by known distance.  The Offset option can only be used if the Radius 

check box is disabled.  If the Radius check box is enabled, then the user can enter the 

desired radius directly from that box.  For Inscribed Polygons, the radius is considered 

the distance from the center point of the polygon to one of the corners of its sides.  For 

Circumscribed Polygons, the radius is considered the distance from the center point of 

the polygon to the center of one of the sides.  For Circles, the radius is the radius of the 

circle.  

Adding a Structural Floor Using Ellipses or Partial Ellipses

The Ellipse and Partial Ellipse buttons are similar to the Circle button, except 
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that a radius cannot be entered.  After clicking the Ellipse button, the user can first click 

the desired center point, and then click the desired distance from the center point to the 

end of the ellipse along its major axis (also known as the transverse radius or major 

radius).  Next, the user can click on the desired distance from the center point to the end 

of the ellipse along its minor axis (also known as the conjugate radius or minor radius). 

To draw a partial ellipse, the user can begin by clicking on the Partial Ellipse button.  A 

partial ellipse is drawn in a similar manner to an ellipse, except that the first point 

clicked is one of the ellipse ends, and the second point clicked determines the distance 

from the first point to the other ellipse end along the major axis.  This distance is also 

known as the transverse diameter.  The third point clicked determines the distance from 

the center point to the end of the ellipse along its minor axis.  This distance is also 

known as the transverse radius.  Once these points have been entered, a half of an ellipse 

is drawn with those distances.  If the Chain box is checked while drawing a partial 

ellipse, then the user can draw another partial ellipse, with the second point clicked on 

the first partial ellipse assumed to be the first point of the next partial ellipse.

Adding a Structural Floor Using the Pick Buttons

The Pick Lines, Pick Walls, and Pick Supports buttons allow the user to select a 

line, wall, or support, respectively, that is already drawn to act as the slab boundary.  The 

Pick Lines button uses the line selected as part of the slab boundary, as opposed to 

drawing a line by clicking on points.  If an architectural background with a slab edge 
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shown is available, then the user can select the lines representing the edge of slab to 

create the slab boundary.  This will save time over having to draw all of the lines by 

tracing the architectural background with the Line tool.  

The Pick Supports button allows the user to click on floor supports such as beams 

or walls, with the center-lines of these supports used as part of the floor boundary.  The 

Pick Walls button allows the user to do the same with walls, except instead of the center-

lines of the walls being used as part of the slab boundary, now the user can select one of 

the wall faces as part of the slab boundary.  If the wrong wall face is clicked, the user can 

switch the wall faces by clicking on the small graphical arrows pointing in different 

directions at the midpoint of the wall.  The option to offset the slab by a specified 

distance is available on the Options Bar for the Pick Lines, Pick Supports, and Pick Walls 

buttons.  The Offset ability will draw the floor boundary line a specified distance beyond 

the chosen line, or center-line of the chosen support or wall.  

Editing and Finishing the Boundary of a Structural Floor

The user can delete, move, extend, or otherwise modify the lines drawn before 

finishing by using the buttons shown on the Edit panel of the Create Floor Boundary 

tab.  The Modify button on the Selection panel can also be used to modify the lines.  For 

instance, the arrows to switch wall faces after using the Pick Walls button can be viewed 

by selecting the wall after having clicked on the Modify button.  Many different options 

will appear on the Options Bar, depending on the element selected.  Once the floor 
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boundary is finalized, the user can click on the Finish Floor button on the Floor panel of 

the Create Floor Boundary tab.  

The floor type chosen will be modeled using the boundary lines that were drawn. 

If the wrong floor type was chosen, the user can click the Modify button of the Selection 

Panel.  After the floor is selected, the user can click the Change Element Type button on 

the Element panel of the Modify Floors tab.  The Instance Properties window can also be 

accessed on the Element panel, by clicking on the Element Properties button.  If the 

bottom part of the Element Properties button was clicked, the user can select Instance 

Properties to open the same window.  Even after the floor has been modeled, the user 

can make modifications to the floor boundary by clicking on the Edit Boundary button 

on the Edit panel of the Modify Floors tab.  After all of the desired changes are made 

and the floor is completed, the user should view the floor in 3D to verify that it was 

modeled as intended.

Figure 23: A 3D View of the Structural Floor for One Level
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14. OPENINGS

Openings are an inevitable necessity in structural slabs, and are needed for 

multiple reasons.  These reasons include architectural design, MEP design, and also 

occasionally construction logistics.  Architectural reasons include the necessity of 

having stair and elevator openings for access between floors.  Other architectural 

reasons include openings for items such as skylights, loft spaces, or double height areas 

among others.  MEP penetrations are needed to run the mechanical, electrical, and 

plumbing systems between floors via ducts, pipes, conduit or any other material used to 

transport the MEP services throughout a building.  Logistical construction penetrations 

could include a temporary opening for a hoist, crane, or concrete pump for which there 

may not be room outside of the building extents.  This is not uncommon, particularly in 

the New York City area, where space and land are limited.  Developers are interested in 

using all available land area for the final product and not for temporary construction 

requirements.  

Other types of openings include openings in walls, or through beams.  Wall 

openings are necessary through shear walls for door access to the stairwells and 

elevators that are often located within the shear core of a building.  Beam openings are 

necessary in cases where there are deep beams that conflict with MEP equipment that is 

running at a certain elevation.  It is not always possible to run the MEP systems below 

the floor structure, particularly in places where the structure is very deep, so 

penetrations through beams are not uncommon.
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It is recommended to use a plan view to model openings in a structural floor. 

After a floor has been modeled, the user can link different backgrounds that were 

provided by either the architect or MEP engineer to show the location and extent of 

openings on a given floor.  If a background is not currently being displayed, the user can 

follow the procedure in the Linking or Importing a CAD Drawing subsection of the 

LINKING OR IMPORTING A DRAWING FILE section.  Once the proper background is 

being viewed, the user can begin to model the openings.  The types of openings are 

shown on the Opening panel of the Modify tab.  These options include the Vertical, 

Shaft, Wall, and By Face buttons.  

The Vertical button is used to model an opening on a particular floor that is not 

likely to occur on multiple floors in the same location.  This may be a good option for a 

unique architectural opening, or smaller MEP openings that will either change size or 

location on different floors.  While the Vertical opening tool is useful for single floor 

openings, there are also openings that will penetrate multiple floors while remaining 

the same size.  

Openings of this type often include elevator and stair openings, or temporary 

construction openings.  These openings create vertical shafts throughout the building 

and can be modeled using the Shaft button.  Note that it is important to verify with the 

designer of the opening that the opening does not change size, shape, or location 

between floors.  The opening designer would be the architect, MEP engineer, or 

construction manager, depending on the reason for the opening.  There are reasons why 
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a shaft opening might change between levels.  

One reason is the requirement of different size stair landings, where different 

floor to floor heights will require different opening sizes.  Since the riser height of each 

step is restricted, the stair may require a greater or less number of steps between 

adjacent floors.  These conditions should be reviewed with the consultant responsible for 

the opening to ensure that the structural engineer has a proper understanding of what 

is required.

The By Face button allows the user to create an opening that is cut perpendicular 

to a selected face.  This is useful when the user needs to model an opening on a sloped 

surface.  This is how the user can model openings in beams.  The By Face button can be 

used on floor slabs, but is not as easy to use as the Vertical or Shaft opening buttons. 

After modeling openings, the user should check the 3D view to ensure that the 

openings were placed in the desired locations.

Adding a One Floor Vertical Opening

To model a one floor vertical opening, the user can click the Vertical button.  The 

Status Bar will tell the user to select a floor, roof, ceiling, or soffit in which to create the 

opening.  The user can select the desired floor by clicking on the floor boundary when it 

is highlighted.  See the subsection on Selecting Elements within THE REVIT USER 

INTERFACE section for more information on selecting elements.  After the element is 

selected, the user can begin to model the boundary of the opening in a similar manner 
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to the way the floor was modeled.  The user can click on points along the opening 

perimeter until a complete boundary is made.  The same options as were given for 

modeling the structural floor are also available for creating an opening.  These options 

include the Line, Rectangle, Inscribed Polygon, Circumscribed Polygon, Circle, Start-

End-Radius Arc, Center-Ends Arc, Tangent End Arc, Fillet Arc, Spline, Ellipse, Partial 

Ellipse, and Pick Lines tools.  Refer the related subsections of the STRUCTURAL 

FLOORS and BEAMS sections for more information on using those drawing tools.  After 

the boundary is created and modified as necessary, the user can click on Finish Opening 

to model the opening.  

Figure 24: A 3D View of the Vertical Openings in a Structural Floor
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Adding a One or Multiple Floor Shaft Opening

To model the shaft opening, the user can click on the Shaft button on the 

Opening panel of the Modify tab.  Now the user can access the Shaft Opening Properties 

tool on the Element panel of the Create Shaft Opening Sketch tab.  This will open the 

Instance Properties window, where the user can select the Base Constraint and Top 

Constraint.  The Base Constraint defines the bottom floor to have the opening, whereas 

the Top Constraint defines the top floor to have the opening.  All floors between these 

two constraints will also have the same opening, creating the shaft.  Once these 

parameters have been set, the user can begin sketching the opening in the same way the 

boundary for a vertical opening or structural floor is drawn.  Upon completion of the 

desired boundary, the user can click Finish Opening to model the opening.  

Adding a Wall Opening

It is recommended to user the 3D view to place the opening on the correct wall, 

and to use an elevation view of the wall to modify the opening.  If there is not already an 

elevation view of this location, a section view can be created or temporarily moved to 

this location to modify the opening.  After viewing the wall in 3D, the user can begin 

placing a wall opening by clicking the Wall Opening button on the Opening panel of 

the Modify tab.  The user can draw the opening on the correct wall and in the correct 

plane, disregarding the opening location and size for the moment.  To do this, the user 

can select the wall to create an opening in by clicking somewhere along the outline of 
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the wall while the outline is highlighted.   Now the user can begin placing the opening 

by drawing a rectangle somewhere within the extents of the wall.  The first click begins 

drawing the rectangular opening, and the second click determines the diagonal 

dimension of the rectangle.  Now that the opening is created, it is suggested that the 

user views an elevation of the wall, where the size and location of the opening can be 

modified.  

After clicking on the opening to select it, dimensions showing its size and 

location will be displayed.  Clicking on these dimensions allows the user to edit them to 

locate the opening relative to the edges of the wall, or enter the size of the opening.  The 

location can also be modified by placing the mouse over the edge of the opening to 

highlight it, and then clicking and dragging the opening.  The size can also be modified 

by clicking and dragging the arrows that are shown on each of the opening edges. 

These arrows allow the user to stretch that opening edge to the desired place.

Adding an Opening By Face

The user can begin modeling the opening by clicking the By Face button on the 

Opening panel of the Modify tab.  When the user places the mouse arrow over a 

potential element to select, a green box will highlight the plane that the opening will be 

cut in.  If the desired plane is not shown initially, moving the mouse arrow up or down 

along the height of the member will change the plane.  The user can click to select the 

plane, and can begin sketching the extents of the opening.  This is similar to the way an 
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opening is drawn in a floor.  The user can draw lines to create a boundary for the 

opening with the ability to modify these lines before modeling the opening.  Upon 

completing the desired opening, the user can click Finish Opening to have the opening 

modeled.

An opening can be placed in a steel beam web for items such as pipe penetrations 

using the Opening By Face tool.  It is recommended that the beam penetration is placed 

in the 3D view.  Then a section or framing elevation view can be used to locate and 

modify the opening size.  This is similar to the case of placing an opening in a wall, 

described in the Adding a Wall Opening subsection.

Figure 25: A Wall Elevation View Showing the Editable Dimensions of an Opening

114



15. STRUCTURAL FOUNDATIONS

Structural Foundations design is a vital part of the design process that needs to be 

submitted earlier than the remaining parts of structure.  A working foundation drawing 

set must be sent to the Department of Buildings early in the design process in order to 

get the paperwork started to expedite construction.  While this may seem to make sense 

since a building is built from the bottom up, it is counter-intuitive from a design 

standpoint.  A building must be designed from the superstructure down because the 

gravity and lateral loads needed to design the foundation are obtained while designing 

the superstructure.  

The gravity loads include the worst case of all of the dead and live loads that a 

building will experience in its lifetime.  The lateral loads include the worst case of all of 

the wind or seismic loads that a building is expected to possibly experience in its 

lifetime according to applicable governing codes.  The loads used to design the 

foundation are a cumulative sum of these loads from following a load path from the top 

of the building down to the foundation.  While these loads can be estimated based on a 

number of assumptions in order to begin an approximate foundation design, there are 

unknowns early in the project.  Ultimately, the foundation design becomes an iterative 

process as more information is known and more accurate loads are obtained.  

The foundation system for projects can vary greatly depending on the soil conditions of 

the particular site where the project will be constructed. 

Foundation walls may be required on projects when excavating below the grade 
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level.  These walls are modeled, however, in the same way as other structural walls.  See 

the STRUCTURAL WALLS section for information on modeling walls.  Isolated 

foundation elements such as pile caps and footings provide the essential means of 

transferring the loads from a structure to the ground where the soil demands require 

them.  Wall foundations are essentially strip footings that are used to distribute the load 

from a wall to the ground below.  Like the walls that they support, the footings are 

designed per foot of length.  In some cases, a structural mat will be used in lieu of 

individual footings or pile caps.  This is because it is more efficient to simplify the 

design into one complete thickened slab for certain situations.  The design of the 

foundation should be understood before attempting to model it.  

Adding a Foundation Slab By Copying A Floor Above

To model a structural mat by creating a new floor, see the STRUCTURAL 

FLOORS section for related information regarding modeling structural floors.  The user 

can add a foundation slab by the same technique as other structural floors.  If there is an 

architectural background available, the modeling procedure is very similar to modeling 

the structural floors mentioned earlier.  Regardless of whether or not there is a 

background, however, it is not uncommon for the foundation level plan to be similar to 

an adjacent floor.  This could also be true for upper structural floors, which can be 

similar or even identical to adjacent floors.  Therefore in some instances, it may save 

time to copy the adjacent floor and modify it, as opposed to having to draw an entirely 
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new floor.   

To copy down the floor above, the user can view the floor to be copied in plan 

view.  The floor can be selected by clicking on its perimeter.  With the floor now 

selected, the user can click the Copy button on the Clipboard panel of the Modify Floors 

tab.  Note that this is different from the Copy button on the Modify panel of the Modify 

Floors tab.  It is recommended to use the clipboard copy as opposed to the modify copy 

because the user will need to switch floor plan views to view the foundation level. 

Switching views after clicking the Copy button on the Modify panel will cancel the copy 

operation.  Clicking the Copy button on the Clipboard panel, however, saves a copy of 

the selected floor to the clipboard.  The the user can click the Paste Aligned drop-down 

menu on the Clipboard panel to paste the floor to the desired level by choosing Select 

Levels.  A Select Levels window will appear showing the available levels onto which the 

structural floor can be pasted.  After the user selects the foundation level, the floor will 

be automatically pasted to that level.  Viewing the model in 3D can confirm that the 

floor was pasted to the correct location.  The user can also go to the foundation level 

plan view to verify that the floor was pasted, and to begin modifying the floor to make 

the foundation slab.  

It is important to be sure that all structural elements are supported by the 

foundation.  This is a significant way that the level above will be different than the 

foundation level.  For instance, any slab edges that were affected by openings near the 

perimeter of the floor will need to be modified in order to have the foundation slab 
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support the walls and structure that encloses these areas.  The user will need to modify 

any places where the slab edge is different from the copied floor.  This can be done by 

clicking on the slab edge to select it, and then clicking the Edit Boundary button on the 

Edit panel of the Modify Floors tab.  This places the drawing in the sketch mode that 

was used to originally create the slab edge.  While in the sketch mode, the user can 

modify the boundary lines that make up the slab edge.  The user can delete lines, draw 

new lines, or stretch existing lines to meet the requirements of the foundation slab. 

When the lines have been edited to complete the foundation slab boundary, the user can 

click the Finish Floor button on the Floor panel of the Modify Floors tab to model the 

new floor boundary.  

The user can edit the structural floor properties to meet the requirements for the 

foundation slab.  The foundation slab will likely have a different floor thickness than the 

structural slab it was copied from, and this parameter can be modified through the 

Element panel.  If the desired type and thickness of floor already exists for the 

foundation slab, then the user can select the foundation slab and change its type on the 

Change Element Type drop-down menu.  This menu is found on the Element panel of 

the Modify Floors tab.  If the desired thickness is not available, however, the user can 

create it on the Type Properties window.  

The user can access the Type Properties window by clicking on the floor to select 

it, then clicking on the Element Properties drop-down menu on the Element panel, 

followed by the Type Properties option.  The desired type of floor can be chosen from 
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the Type drop-down menu, disregarding the thickness.  In order to create a new 

thickness of the floor type selected, the user can click on the Duplicate button adjacent 

to the Type drop-down menu.  When the Name window opens, the user can name the 

new floor type.  It is recommended to include the floor thickness and floor type within 

the name.  The user can click OK after the new floor type has been named, which will 

show the new type on the Type drop-down menu.  Note that the thickness, however, will 

still show the value from the floor type that was duplicated.  The user can modify this by 

clicking on the Edit button of the Structure parameter, and then typing in the desired 

thickness for the Structure function under the Thickness column on the Edit Assembly 

window.  Clicking OK will update the thickness on the Type Properties window. 

Clicking OK on the Type Properties window will give the modeled floor the properties 

of the new floor type.  It is recommended that the user view the foundation level in 3D 

to verify that the modified slab edge, floor type, and thickness are shown as desired.  

There is a Slab button on the Foundation panel of the Home tab.  This button 

opens the same Create Floor Boundary tab as the Floor button on the Structure panel of 

the Home tab.  Foundation slab types can be selected or created using either button.  If 

the bottom portion of the Slab or Floor button is clicked, it will display a drop-down 

menu with the option to place a Slab Edge.  This allows the user to create a thickened 

portion at the slab edge.  A haunch such as this in the slab can be used at the ends of 

slabs on grade, where the slabs can be tied to foundation elements below.  In other 

instances, this haunch can serve as a thickened element to transfer load to the soil 
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below.    

Figure 26: A 3D View of a Mat Foundation and Foundation Walls

Adding Isolated Foundation Elements

It is recommended to create isolated foundation elements in plan view.  The user 

can click on the Isolated button of the Foundation panel on the Home tab to begin 

modeling isolated foundation elements.  The list of available isolated foundation 

elements can be viewed by clicking on the Change Element Type drop-down menu on 

the Element panel of the Place Isolated Foundation tab.  

If the desired type is not on the list, it can either be loaded or created.  There are 

numerous pile cap layouts that can be loaded by clicking on the Load Family button on 

the Model panel of the Place Isolated Foundation tab.  After locating the foundation 
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folder, there will be a list of various specific and generic pile cap layouts, as well as 

different types of piles.  If the desired size is not available, the user can create it by 

accessing the Type Properties window.  This window can be opened by clicking on the 

drop-down portion of the Element Properties button.  It can also be found by opening 

the Instance Properties window by clicking on the Element Properties button and then 

clicking on the Edit Type button.  The user can clicking on the Duplicate button to 

rename a copy of the foundation element.  This copy can be edited by entering the 

desired dimensions on the Type Properties window.  When the user clicks OK, the edited 

dimensions and new isolated foundation element type will be saved.

Once the desired type is selected, the user can begin placing the elements into 

the model.  The elements are drawn by clicking on a single point, which will be the 

center-point of the element.  The Option Bar only has one option for placing isolated 

foundation elements.  This option is the Rotate After Placement check box.  When this 

check box is enabled, the user will automatically have the ability to rotate the element 

immediately after placing it.  After selecting the desired rotation by clicking at the 

appropriate angle, the user will have the opportunity to place additional elements.  With 

the check box disabled, the user can click on new locations for additional foundation 

elements after clicking on a location for the first element.  The user also has the ability 

to rotate an element prior to placement by pushing the Space bar, which can be quicker 

than using the Rotate After Placement option.

It is structurally ideal to have the center of the foundation element line up with 
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the center of a column.  This is not always possible, however, requiring some foundation 

elements to be moved after placement.  After clicking on the foundation element to 

select it, the user can click the Move button on the Modify panel of the Modify 

Structural Foundations tab.  Now the user can move the element by clicking on a base 

point with which to move the element, and then clicking on a new location for the base 

point. 

The properties of isolated foundation elements can be modified through the 

Instance Properties window.  This window is found by selecting one or more isolated 

foundation elements, and then clicking the Element Properties button on the Element 

panel of the Modify Structural Foundations tab.  The user can change parameters such 

as the element's Type, Level, Offset, Material and Structural properties on the Instance 

Properties window.  

The Type drop-down menu allows the user to change the type of isolated 

foundation element.  The Level constraint allows the user to change the level that the 

isolated foundation is modeled on.  The Offset constraint determines the dimension by 

which the top of the isolated foundation element will be offset from the specified level. 

The Offset parameter will become an important property to monitor as the project 

progresses.  All of the foundation elements will probably not start at or remain at the 

same elevation.  It is common for there to be different offsets due to constraints from 

the architect, MEP engineer, geotechnical engineer or other design consultants. 

Different level foundations can be required for basement storage areas, electrical vaults, 
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elevator pits, underslab drainage systems and other conditions that affect individual 

isolated foundations.  Note that the Offset parameter may need to be changed as more 

specific information is known about the design of the lowest level.  The Material 

parameter allows the user to change the material of the isolated foundation element. 

The Rebar Cover parameter allows the user to input the desired concrete cover from the 

rebar to the edge of the isolated foundation element.  

Adding Wall Foundations

To draw a wall foundation, it is recommended to start in the plan view showing 

the wall that the foundation will be supporting.  Once in the appropriate view, the user 

can click on the Wall button on the Foundation panel of the Home tab to begin 

modeling.  The user can select the desired type of Wall Foundation on the Change 

Element Type drop-down menu of the Place Wall Foundation tab.  The two default types 

of wall foundations are a bearing footing and a retaining footing of specific size.  

If the desired size is not one these types, it can be created by clicking on the 

Element Properties button to access the Instance Properties window.  The user can select 

the footing that is the correct type except for its dimensions from the Type drop-down 

menu.  Clicking on the Edit Type button will make this type appear in the Type drop-

down menu on the Type Properties window, where a new size of this type can be created 

by clicking on the Duplicate button.  After renaming the footing to include the desired 

size in the new name and clicking OK, the new dimensions can be entered next to the 

123



appropriate dimension parameters.  Clicking OK on the Type Properties window saves 

the new type and size.  

After selecting the desired type of footing, the user can select the wall to place 

the new foundation under by clicking on a wall.  This automatically models the new 

footing as the foundation element for the wall along its center-line.  The wall can be 

offset from the wall center-line by changing one of its parameters on the Instance 

Properties window.  The first parameter under Constraints is the Eccentricity parameter, 

where the user can enter a dimension with which to offset the foundation from the wall. 

Note that the dimension entry will be ignored if it will result in the wall not resting on 

top of the foundation.

Figure 27: A 3D View of Isolated Foundation Elements
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16. REVIT STRUCTURE EXTENSIONS

Autodesk released a series of extensions for Revit Structure that allows the user 

to broaden the program's capacity in particular areas of interest to structural engineers. 

These areas include extensions for a range of abilities from structural analysis and 

design to construction documentation and reinforcement modeling.  The Revit 

extensions specifically for Revit Structure 2010 has applications for structural detailing, 

structural analysis, reinforcement of structural elements, and steel connection modelers 

among others.  The structural analysis extension has the ability of exporting a structural 

model into Autodesk Robot Structural Analysis.  

Robot Structural Analysis allows structural engineers to perform analysis on 

structures through a series of analysis capabilities to evaluate the behavior of a structure 

under different types of loading.  The program contains finite element capabilities to 

mesh the structure for analysis, as well as design codes and the capacity to design 

reinforced concrete and steel members.  After a model has been developed in Revit 

Structure, it can be analyzed and designed in Robot Structural Analysis, and the 

designed structural model can then be returned to Revit Structure with the updated 

designed members.  Robot Structural Analysis can also export the results into 

Autodesk's structural detailing software to create fabrication drawings from the design. 

While these are only a few examples, the interoperability of programs like these from a 

single model allows the user to explore the true benefits of BIM programs.
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17. REVIT ON REAL CONSTRUCTION PROJECTS

The use of Revit was discussed with multiple engineers from a reputable 

structural engineering firm.  Some insight was gained from these engineers' experience 

with using Revit on real construction projects within the New York metropolitan area. 

The following includes a summary of the opinions of these engineers based on their 

personal experiences. 

General Comments From a Structural Engineering Standpoint

The material choice for the building structure typically has a direct impact on 

the usefulness of the program for structural engineers.  For concrete buildings, the 

biggest advantage of using Revit for a structural engineer is mostly only as a tool to 

coordinate amongst the design team.  Particularly in New York, it seems that the 

industry's concrete contractors do not have an interest in using Revit.  It is worth noting 

that the time requirement to build a Revit model for a concrete building is typically less 

than that for a steel building.  

If the structure of a steel building is more complex, however, Revit becomes 

more useful as a tool for the structural engineer.  Revit's three-dimensional model 

assists in the observation of the complex geometries of the project.  It seems that the 

steel subcontractors in the local industry commonly use TEKLA 3D models for their 

purposes, as opposed to Revit.  From experience with viewing a TEKLA 3D model, it was 

extremely helpful in understanding the complexity of structure that occurred at 
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different locations.  These aspects of the project were easily overlooked without the help 

of the 3D model.  Using the model to locate and understand these conditions provided 

valuable insight into how to design, detail, and ultimately construct the varying 

conditions.  This is a testament to usefulness of a 3D model, such as one produced 

through Revit or TEKLA.

Regardless of the material type, it was recommended to start the model as late in 

the design phase as possible.  The reason for this is so the structural engineer has as 

much information as possible when starting the model.  Since it is very time consuming 

to build a model as compared to producing traditional AutoCAD plans and details, the 

goal is to avoid the many changes that are inevitable at the earliest stages of the design. 

As a rule of thumb, it was suggested to not start a Revit model earlier than the Design 

Development phase of a project.  The Schematic Design phase is too early in the process 

with too many variables for the model to be particularly useful and developed 

efficiently.

One additional possible use for Revit models is as a marketing tool for the 

developer.  Although this does not apply particularly to Revit Structure, as the structure 

is often enclosed and hidden, Revit Architecture can be very useful to the developer for 

this cause.  Revit Structure does, however, provide some marketing value to the 

structural engineering firm.  Since Revit Structure can provide varying views and 

renderings of the project's structure, these can be used when marketing the firm's 

project experience.  
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While Revit can be a very useful tool for structural engineers, it is thought that it 

could have a greater impact on the other fields of the building design industry.  For 

instance, MEP engineers have various layers of mechanical, electrical, and plumbing 

lines that cross each other in multiple places on a single floor.  Using a two-dimensional 

drawing to display such information is not particularly effective.  A Revit model is far 

more advantageous by having the ability to view the different elevations of these 

systems in 3D.  Having a Revit Structure model to compare to the Revit MEP model is 

also useful in determining any conflicts that the may occur between the MEP 

equipment and structural elements of the project.  This is an example of how a 

structural Revit model is helpful for coordinating amongst the other design consultants.

Issues With Using Revit On Real Construction Projects

While Revit is a very useful tool with a lot of potential, it seems from experience 

that using Revit on real construction projects changes the natural progression of the 

project.  The problem does not seem to stem so much from the structural engineer 

using Revit Structure, but more from the architect using Revit Architecture.  The reason 

for the changes to a project's development is that Revit Architecture demands a very 

large quantity of detailed information from an architect in order to create a model.  This 

demand for so much detail changes the order by which architectural information is 

typically shared.  

 For both previous and currently ongoing projects, some architects have been 
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caught up in some of the lesser details of a project because these details are necessary to 

produce the architectural model.  In turn, developing these details has affected the flow 

of information by slowing down the normal progression of architectural design. 

Without receiving the necessary architectural information to design their aspects of a 

project, the structural engineer's and other design consultants' production is delayed. 

These delays inevitably affect the construction schedule of the project by forcing a 

slower schedule in comparison to the current project development process when only 

using AutoCAD to produce construction documents.  

Revit has many potential connectivity abilities that would allow the user to 

streamline the process of taking information from one place and using it elsewhere.  For 

instance, the program has the potential to export the structural model into other 

structural analysis and design programs.  Through the use of this process, a structural 

engineer would be able to greatly reduce the amount of time it currently takes to create 

a separate model in each of these analysis and design programs.  Unfortunately at this 

point in time, however, it seems that the industry has not yet been able to fully take 

advantage of abilities such as these.  The programs have not been able to connect in the 

ideal way intended, and there has been a need to develop workarounds for exporting the 

model.

Another potential connectivity ability would help quicken the process of sharing 

information between multiple design consultants.  For instance, structural engineers 

could ideally link their models with architectural and MEP models.  Doing so would 
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allow the user to automatically update the model to include the most recent changes 

made to the architectural and MEP models.  The respective consultants on current and 

past projects, however, have not yet been able to link their models in this way.  The 

potential gains from working out the kinks of this ability are immense, as the flow of 

information among the design team is one of the most important aspects of a project in 

design.

Multiple users are also potentially able to work on a single model at the same 

time within Revit.  This has been an unresolved issue with AutoCAD in that two 

different users could not access the same drawing simultaneously to make changes.  At 

best, one user can access the original drawing file, while a different user must work on a 

copy of the file.  The modifications made to the copy then need to be pulled from the 

copy and placed on the original drawing file.  Revit has the potential ability for multiple 

users to work on a single model file through a series of permissions and releases that 

restrict which parts of the model different users can modify.  While the idea is 

progressive, it has not proven to be particularly practical on actual projects.  It seems 

that users are constantly required to change the permissions and releases settings that it 

becomes more burdensome than advantageous for multiple users to simultaneously 

work on a single model.

The actual tools for producing construction documents within Revit have not yet 

been fully developed enough for the industry to comfortably use Revit alone in creating 

construction documents.  On previous projects, structural engineers have had to create 
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the final drawing sheets in AutoCAD, as opposed to Revit.  The reason for this is that 

since the model has such an immense amount of information within it.  It is difficult or 

seemingly impossible at times to display only the desired portions of projects within the 

viewing areas.  Even trained expert Revit modelers have had to come up with 

workarounds for attempting to display the desired information.  

A liability issue exists with the prospect of a designer, such as an engineer, 

handing over a three-dimensional model to a contractor.  The liability is in the 

contractor using information that can be taken from the model that is not under the 

control of the designer.  Similar liability exists with releasing electronic AutoCAD 

drawings to a contractor.  The designers attempt to deal with this issue by using legal 

verbiage that restricts the contractor from taking electronic information at face value. 

For example, designers often include a note with their drawings stating that the 

drawings may not be scaled to retrieve dimensions.  Only dimensions that are 

specifically shown for the elements that have been designed by the designer may be 

used by the contractor.  

The amount of information and liability, however, increases greatly in magnitude 

with releasing a three-dimensional model because of the larger amount of information 

that can be extruded from it.  While the legal aspects of the liability can potentially be 

worked out through contract and specification writing, the reliance of the contractor 

when producing the model will be much more difficult to monitor.  If the liability issues 

can be resolved, however, the three-dimensional model can serve as a significant tool by 
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which all trades involved can improve the efficiency and quality of their work.

Heavy reliance on the three-dimensional model is not only limited to contractors 

in terms of being a disadvantage of using Revit.  Some design consultants have shown a 

tendency to remove their impact on the coordination required when designing a project 

by relying on the model too heavily.  While the model is a useful tool for determining 

conflicts within a project, it is neither infallible nor all-knowing.  There is an 

irreplaceable need for a professional to be present and active in finding and solving a 

project's problems.  Every project will present new and different challenges to overcome. 

Without actively participating in understanding the intricacies of each project and how 

the different design participants must interact, the designer merely becomes a technical 

operator of a design tool.  
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18. CONCLUSIONS AND RECOMMENDATIONS

Revit Structure is a powerful tool that structural engineers can use to develop a 

three-dimensional model to aid in the design of a project, and develop the documents 

required to construct a project.  In order to maximize the value of using Revit Structure, 

the user must fully understand the tools and abilities of the program, as well as the 

process of producing a project through completion.  By having a greater understanding 

for the process by which projects are created, modelers can produce a working model in 

an efficient manner.  While there are disadvantages to using such a tool in the lieu of 

older more established methods such as producing traditional AutoCAD drawings, there 

are also many advantages to be gained.

The aforementioned issues cannot be overlooked when intending to use Revit on 

a real construction project, especially considering that improved coordination is 

supposed to be one of the program's greatest advantages.  Future releases from 

Autodesk may help fix any bugs or limitations that are preventing users from exploring 

the full potential of the program.  Autodesk is working on particular issues to resolve 

some of the program's shortcomings.  There are intended release dates in the upcoming 

years for a series of updates that are aimed at remedying the program's pitfalls.  

Perhaps some of the issues can also be resolved through more experience and 

comfort with the program.  As the case seems to be based on actual projects employing 

the program, the users of the program within the industry are not quite there yet.  Due 

to the perpetual state of rush that the industry faces, many users of the program have 
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not yet been able to master the program's abilities.  Organizations are, however, aiding in 

the spread of information that will lead to more productive and efficient use of BIM 

programs.  Books are being released, seminars are being held, and articles are being 

distributed to promote the advantages and widespread acceptance of BIM programs 

such as Revit within the industry through smarter use and application.  Since this is a 

relatively new program in terms of its actual use on real construction projects, the same 

familiarity that has been gained with AutoCAD over decades of use has not yet been 

experienced with Revit.  

With time, the program will be improved by new updates and editions, and the 

industry will become more familiar with its use.  Just as AutoCAD had become the 

industry standard over hand drawn documents by overcoming the initial obstacles it 

faced, three-dimensional BIM programs such as Revit will lead the way to a new 

industry standard by providing unique and remarkable advantages to the construction 

industry. 
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